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1
Accessibility in EPM System

Oracle Enterprise Performance Management System offers standard accessibility and
assistive technology features that can be used across all pages. This guide provides additional
non-standard accessibility options for navigating EPM System

Reading through this guide

This chapter provides information on available non-standard accessibility features, enabling
settings for assistive support, and access keys to navigate across EPM System tasks.

If you are looking for accessibility features for a specific application, go to the relevant chapter
for that application. For example, the chapter on Planning provides accessibility features when
you are in the Planning application.

Enabling Screen Reader Support
You must enable screen reader support in order to use screen readers, magnifiers, and other
accessibility tools to work in Oracle Enterprise Performance Management System. Enabling
screen reader support is a preference setting in Oracle Hyperion Enterprise Performance
Management Workspace. When you enable screen reader support in EPM Workspace, you
enable screen reader support for all integrated components (for example, Oracle Hyperion
Shared Services Console, Oracle Hyperion Planning, Oracle Hyperion Calculation Manager,
and so on). If you change the Accessibility Mode setting during a session, you must log off and
restart the browser for this change to take effect.

EPM System supports the newest versions of Assistive Technologies such as JAWS and
MAGic.

Note:

• If you are using JAWS screen reader, Oracle recommends using the Microsoft
Edge browser.

• Oracle does not recommend using JAWS and MAGic simultaneously or using
MAGic as a screen reader.

• When screen reader support is enabled, progress indicators are not available.

To enable screen reader support:

1. Access EPM Workspace.

2. Select File, and then Preferences.

3. In the Preferences dialog box, under Accessibility Mode, select Enable Screen Reader
Support.

This option optimizes EPM System to work with screen readers.

4. Click OK.
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Access Keys for Navigation Across EPM System
This section lists the non-standard access keys to navigate across all pages in the Oracle
Enterprise Performance Management System environment:

• Button Mnemonics on Supported Web Browsers

• Common Access Keys

• Access Keys for Tables, Nested Tables, and Nested Lists

Button Mnemonics on Supported Web Browsers

The underlined letter that typically appears in a menu title, menu item, or button text is called a
mnemonic. The following tables describes access keys for various browsers.

Browser Operating System Keys Action

Google Chrome Linux Alt+mnemonic Click
Google Chrome Mac OS X Ctrl+Option+mnemonic Click
Google Chrome Windows Alt+mnemonic Click
Mozilla Firefox Linux Alt+Shift+mnemonic Click
Mozilla Firefox Mac OS X Ctrl+mnemonic Click
Mozilla Firefox Windows Alt+Shift+mnemonic Click
Microsoft Edge Windows Alt+mnemonic Click or set focus
Apple Safari Windows Alt+mnemonic Click
Apple Safari Mac OS X Ctrl+Option+mnemonic Click

Common Access Keys

Keys Components Action

Enter
Space

All components Activates the component, or the component
element that has the focus

Ctrl+A All components Selects all
Left Arrow
Right Arrow

Menu
Input Number slider
Input Range slider

Moves focus to different menu on a menu bar
Moves slider left or right when input number
slider or input range slider is in focus

Up Arrow
Down Arrow

Menu
Input Number Slider
Input Range Slider

Moves focus to different menu items in a menu
Moves slider up or down when input number
slider or input range slider is in focus

Shift+F10 All components Displays cell context menu

Access Keys for Tables, Nested Tables, and Nested Lists

Keys Components Action

Tab
Shift+Tab

Table
Nested Table

Moves focus to next or previous cell or editable
component
If the focus is on the last cell of a row in the
table, the Tab key moves focus to the first
editable cell in the next row. Similarly,
Shift+Tab moves focus to the previous row.

Chapter 1
Access Keys for Navigation Across EPM System
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Keys Components Action

Ctrl+A Table
Nested Table

Selects all components, including column
headers, row headers, and data area

Shift+F10 Table
Nested List
Nested Table

Launches context menu

Enter
Shift+Enter

Table
Nested List
Nested Table

Navigates to the next editable cell or previous
editable cell of the column
If focus is on the column header, sorts table
data in ascending order. Pressing Enter again
sorts the column in descending order
If the focus is on the filter cell, performs table
filtering
In a click-to-edit table, if the focus is on a cell,
enables edit mode

Left Arrow
Right Arrow

Table
Nested Table

Moves focus

Up Arrow
Down Arrow

Table
Nested Table

Moves focus
Scrolls the table one row up or down

Page Up
Page Down

Table
Nested Table

Scrolls by one page

Space
Ctrl+Space

Table
Nested List
Nested Table

Selects the node
Selects column

Shift+Space Table
Nested Table

Selects rows

Esc Table
Nested Table

Removes selection
If the focus is on the cell, exits click-to-edit
mode, then reverts the cell value to original
value, and returns focus to the cell. Press Esc
key again to move focus to the row header.

Oracle Accessibility Support
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&ID=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&ID=info, or visit http://
www.oracle.com/pls/topic/lookup?ctx=acc&ID=trs if your are hearing-impaired.

Chapter 1
Oracle Accessibility Support
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2
Accessibility in EPM Workspace

This chapter provides non-standard accessibility options for navigating EPM Workspace in the
following areas:

• Using the Tab Key in EPM Workspace

• Using Global Navigation Shortcuts

• Accessibility Behaviors for General UI Elements

• Accessibility Behavior for Nonstandard Controls

• Using the Home Page

Using the Tab Key in EPM Workspace
The default tab order in Oracle Hyperion Enterprise Performance Management Workspace
flows from left to right, top to bottom. The component order is: toolbar, search control, view
pane, content area, content area (bottom) tab bar. The tab order loops in both directions so
that tabbing from the last item focuses the first item, and reverse-tabbing from the first item
focuses the last item. The main menu bar is not included in the tab order (use shortcut keys to
access menu items).

Using Global Navigation Shortcuts
Table 2-1    Global Navigation Shortcuts

Keys Action

F1 Opens help for the active UI area.
F10 Move focus to the first menu in the menu bar.
Ctrl+Alt+0 Move focus to the first focusable child in the tab order in the current view

pane. If there is no view pane, nothing happens.
Ctrl+Alt+1,
Ctrl+Alt+2,
Ctrl+Alt+3,
Ctrl+Alt+4,
Ctrl+Alt+5,
Ctrl+Alt+6,
Ctrl+Alt+7,
Ctrl+Alt+8,
Ctrl+Alt+9

Same as Ctrl+Alt+0, but the action applies to the specified view pane. For
example, pressing Ctrl+Alt+3 moves focus to the first focusable child in the
tab order in the third view pane.

Ctrl+Shift+1 Toggle to show or hide the masthead
Ctrl+Shift+2 Toggle to show or hide the view pane
Ctrl+Shift+F Move focus to the Search field.
Ctrl+Shift+F4 Close current active module: document, task, or file. If none are open,

nothing happens.
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Table 2-1    (Cont.) Global Navigation Shortcuts

Keys Action

Ctrl+Shift+G Move focus to the Oracle Hyperion Enterprise Performance Management
Workspace Content tab bar, which lists open modules. Focus moves to the
current module tab. If multiple documents are open, the current module tab
is highlighted. If no tabs are open, nothing happens.

Ctrl+Shift+L Presents a list of selectable navigation targets in the Links List window:
• Go to View Pane
• Go to Content Area
• Go to Related Content Area
• Go to Annotations Area
• Go to Tab Bar
• Go to Toolbar
• Go to Menubar

Ctrl+Shift+A Move focus to the Standard toolbar. Use the Tab key to select individual
buttons.

Ctrl+Shift+Y Move focus to the Content area. This transfers focus to the first focusable
child in the tab order of the Content area of an active document.

Alt+mnemonic Move focus to the menu in the menu bar that has the mnemonic you use.

Accessibility Behaviors for General UI Elements
Listed below are specific keystrokes for User Interface (UI) elements, as well as expected
screen-reader behavior when a UI element has focus:

Table 2-2    User Interface Element Types

UI Element Action

Button Either Enter or Space activates the button, causing the same action as a left
click.
Note: In Microsoft Edge, the button accelerator is triggered by Alt+<letter>;
in Mozilla Firefox, it is triggered by Alt+Shift+<letter>.

ComboBox • Up or down arrow keys display the popup menu and enable value
selection.

• Space or Enter selects an item.
• If editable, alphanumeric keys cause an edit.

Dialog • If the dialog has an accept button defined, press Enter to activate it.
• The dialog is modal and blocks all other keyboard events.

Content Area
(IFrame)

• Press Ctrl+F6 to enter a frame. You may need to press Tab to select the
first focusable item.

• Press Ctrl+Shift+F6 to exit the frame content area and return focus to the
frame.

List • The up or down arrow keys move selection focus up or down through
the list elements. The selection is continually updated.

• Ctrl+Up or Ctrl+Down moves focus up or down without changing the
current selection. Press Spacebar to add the item to the selection.

• Shift+Up or Shift+Down key moves focus up or down and adds the item
with focus to the selection.

Note: If the list supports only a single selection, the Ctrl and Shift modifiers
have no effect.

Chapter 2
Accessibility Behaviors for General UI Elements

2-2



Table 2-2    (Cont.) User Interface Element Types

UI Element Action

Tab Bar Left or right arrow key moves selection focus and selects the new tab
immediately. Selection focus wraps around the ends of the tab bar.

Text Field • If editable, alphanumeric keys cause an edit.
• Pressing Tab moves focus to the next element in tab order. Tab cannot be

entered as a character in the text field.
Tree The left and right arrow keys collapse or expand the current node if it has

children. If it has no children, there is no effect. The expansion is not
recursive. However, if the tree is capable of remembering the previous
expansion state of any subnodes, it should do so.

Accessibility Behavior for Nonstandard Controls
Related Topics

• Content Tab Bar

• Accessibility for Sidebar Icon List

Content Tab Bar
When focus is on the Content tab bar, selection focus is on the current tab, if any.

Table 2-3    Content Tab Bar— Accessibility Keys

Keys Action

Right/Up
arrows

When on any document content tab, the next tab to the right is selected. The
selection wraps from the rightmost tab to the leftmost.

Left/Down
arrows

When on any document content tab, the next tab to the left is selected. The
selection wraps from the leftmost tab to the rightmost.

Accessibility for Sidebar Icon List
The following keyboard shortcuts are supported for the sidebar icon list for the File menu
Preferences and Properties options.

Table 2-4    Sidebar Icon List — Accessibility Keys

Keys Action

Tab/Shift+Tab Navigate up/down the items in the list.
Space bar Select the item in the list that has focus.

Using the Home Page
The following navigation keys are used to navigate within the Home page:

• Tab: Focuses the next item in the region if one exists, otherwise the next region if focused
on the last item in the region.

Chapter 2
Accessibility Behavior for Nonstandard Controls

2-3



• Shift+Tab: Focuses the previous item in the region if one exists, the region itself if focused
on the first item in the region, otherwise the previous region if focused on the region itself.

Table 2-5    Navigation Keys for the Home Page

Key Action

Up Scrolls the region up, if possible.
Down Scrolls the region down, if possible.
Left Scrolls the region left, if possible.
Right Scrolls the region right, if possible.
PgUp Scrolls the region up a page, if possible.
PgDn Scrolls the region down a page, if possible.
Home Scrolls the region to the top, if possible.
End Scrolls the region to the bottom, if possible.
Shift+Up Focuses the region above, otherwise wrap around to the bottom region.
Shift+Down Focuses the region below, otherwise wrap around to the top region.
Shift+Left Focuses the region to the left, otherwise wrap around to the rightmost

region.
Shift+Right Focuses the region to the right, otherwise wrap around to the leftmost

region.
Shift+PgUp Focuses the previous region, otherwise wrap around to the last region.
Shift+PgDn Focuses the next region, otherwise wrap around to the first region.
Shift+Home Focuses the first region.
Shift+End Focuses the last region.
Space bar or
Enter

Executes the item action, or expands/collapses the item group.

Chapter 2
Using the Home Page
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3
Accessibility in EPM System Applications

This chapter provides non-standard access keys and other assistive support for navigating the
following Oracle Enterprise Performance Management System applications:

• Data Management

• Essbase

• Financial Performance Management

• Financial Reporting

• Foundation Services

• Planning

• Predictive Planning in Smart View

• Profitability and Cost Management

Data Management
Related Topics

• Data Relationship Management

• Financial Data Quality Management Enterprise Edition

Data Relationship Management
Related Topics

• About Data Relationship Management Suite

• Accessibility Features

• Keyboard Equivalents

About Data Relationship Management Suite
Oracle Data Relationship Management Suite consists of:

• Oracle Data Relationship Management

• Oracle Data Relationship Management Read Only Access

• Oracle Data Relationship Steward

• Oracle Data Relationship Governance

• Oracle Data Relationship Management Analytics

• Oracle Data Relationship Management for Oracle Hyperion Enterprise Planning Suite

• Oracle Data Relationship Management for Oracle Hyperion Financial Close Suite

3-1



Accessibility Features
Accessibility in Oracle Data Relationship Management is enabled by default with this
functionality:

• Support for screen readers and magnifiers.

• Keyboard navigation equivalents for all objects.

• Tab indexing, implemented from left to right on all pages.

• Alt and title attributes for all objects, images, and page titles.

• Pages that provide drag and drop operations also support alternative methods of
operation.

Keyboard Equivalents
The following sections describe keyboard equivalents.

Grid Keyboard Equivalents

The following keyboard equivalents are used in grids.

Keyboard Equivalent Action

Up/Down Arrow Focus on a row

Space Select or deselect a row

Shift-Up/Down Arrow Select multiple rows

Shift-Page Up Go to previous page

Shift-Page Down Go to next page

Tree Keyboard Equivalents

The following keyboard equivalents are used in trees.

Keyboard Equivalent Action

Up/Down Arrow Focus on a row

Space Select or deselect a row

Right Arrow or Plus (+) Expand a row

Left Arrow or Minus (-) Collapse a row

Shift-Page Up Go to previous page

Shift-Page Down Go to next page

Financial Data Quality Management Enterprise Edition
Related Topics

• Accessibility Features

• Recommended Screen Reader Settings

• Using Screen Reader Mode

Chapter 3
Data Management
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Accessibility Features
Tab Indexes are provided for group boxes, text boxes, and buttons.

Tip:

To have your screen reader announce the number of items in a group box, click Alt
and the Up Arrow key.

Abbreviations such as "POV" for Point of View are used across screens. Screen readers will
read them as "POV" instead of "pee-oh-vee". To add abbreviation equivalents to the screen
reader dictionary, so that you can replace "POV" with "Point of View" , refer to your screen
reader documentation.

Recommended Screen Reader Settings
• Turn PC Cursor Mode ON when tabbing through read-only fields in a table.

• Turn PC Cursor Mode OFF when entering data in editable fields.

Using Screen Reader Mode
Note the following:

• Use buttons, radio buttons, and check boxes for selection.

• Click icons for additional information.

• When a popup such as a confirmation of information message appears after you save or
launch a rule, use the Down Arrow keys to read the message after the screen reader
announces the popup.

Essbase
For information on accessibility in Oracle Essbase 21C, see Oracle Essbase Accessibility in
Getting Started with Oracle Essbase.

Financial Performance Management
Related Topics

• Financial Management

• Tax Provision

Financial Management
Related Topics

• Financial Management Accessibility Features

• Financial Management Keyboard Equivalents

Chapter 3
Essbase
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Financial Management Accessibility Features
Tab Indexes are provided for Groupboxes, TextBoxes, and Buttons.

Note:

The JAWS screen reader can announce the number of items in a group box if you
click Alt and the Up arrow key.

Abbreviations such as "POV" for Point of View are used across screens. Screen readers read
them as "POV." To add abbreviation equivalents in the Screen Reader dictionary, such as
replacing "POV" with "Point of View," refer to your screen reader documentation.

All reports that use the HFM_format style can be accessed using JAWS table reading
commands.

Financial Management Keyboard Equivalents
These sections describe the keyboard equivalents for Oracle Hyperion Financial Management
applications by module.

To use shortcut keys, select Alt, then the keyboard shortcut, and then press Enter. For
example, to view logged-in users, select Alt+i, then Enter.

For multiple selections, you can use Shift+F8. When this mode is enabled, you can move up or
down the list of choices and press the spacebar to select multiple items, or press the spacebar
again to deselect an item.

You can use Alt+Z as a shortcut key to go to the beginning of any page. You can also use
Alt+Z to navigate to a floating frame when loading a page. In certain cases, when a page is
refreshed as a result of an action, the focus goes to the top of the Financial Management
content area. You can navigate using Tab or shortcut keys.

File Menu

Use these keyboard shortcuts from the File menu. Select File (Alt + f), then New (n), and then
an option.

Table 3-1    File New Menu Keyboard Shortcuts

Keys Action

g Data grid

f Data form

l Link

r Related Content

k Tasklist

For new System Reports, use these keyboard shortcuts from the File menu. Select File (Alt +
f), then New (n), then System Report (s), and then an option.

Chapter 3
Financial Performance Management
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Table 3-2    System Report Menu Keyboard Shortcuts

Keys Action

j Journal

I Intercompany

d Data grid

t Intercompany Matching template

n Intercompany transactions

c Intercompany Matching by Account

m Intercompany Matching by Transaction ID

View Menu

Use these keyboard shortcuts from the View menu. Select View (Alt + v), and then an option.

Table 3-3    View Menu Keyboard Shortcuts

Keys Action

m Advanced Mode

Administration Menu

These keyboard shortcuts are used in the Administration menu. Select Administration (Alt + a),
and then an option.

Table 3-4    Consolidation Application Administration

Keys Action

d Manage Documents

f Manage Favorites

s System Messages

u Users on System

r Manager Servers and Applications

k Task Audit

t Data Audit

i Running Tasks

x Extended Analytics

c Copy Document Link

l Manage Taskflows

v View Taskflow Status

w Manage Smart View Providers

n Import Application

p Profile Editor

Chapter 3
Financial Performance Management
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Navigating to the Application

Table 3-5    Application Navigation Shortcuts

Keys Action

Alt_z or Ctrl+F6 Tab iFrame- Main content area

Alt+q iFrame - Popups (when iFrame receives focus)

Alt+L Close popups

Alt+y Access contents of the selected tab page

Shortcut Keys by Module

Table 3-6    Users on System

Key Action

I Log out users

g Enable connections

o Disable connections

\ View disabled somponents

/ Enable (common for all rows)

Table 3-7    Manage Servers and Applications

Key Action

g Log out users

e Enable connections

s Disable Connections

I View disabled components

n Enable (common for all rows)

Table 3-8    System Messages

Key Action

I View system messages

[ Calendar start

] Calendar end

s Show Details

e Delete system messages

l Delete All system messages

+ Select All system messages

u Anchor tag for error details. Same for each row

\ Previous page

/ Next page

p Print Error Details page

l Close

Chapter 3
Financial Performance Management
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Table 3-9    Running Tasks and popup menu

Key Action

I View Running Tasks

x Stop running task from popup menu

q Stop running task from popup menu

q From Running Task Log page, navigate to top

r Refresh

l Close

Table 3-10    Extended Analytics

Key Action

s Save template as

p Delete template

o Refresh template

c Create Star Schema

e Delete Star Schema

u Update Star Schema

s Save template

l Cancel

Table 3-11    Data Audit

Key Action

[ Start date

] End date

\ Previous

/ Next

Same as POV bar POV

I View

l Clear Log

x Export

Table 3-12    Task Audit

Key Actions

[ Start date

] End date

\ Previous

/ Next

I View

l Clear log

x Export

o OK in Task Audit Export page

Chapter 3
Financial Performance Management
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Table 3-13    Load Security

Key Action

m Security file

l Load

k Back to Load Security

Table 3-14    Load Metadata

Key Action

m Metadata file

l Load

s Scan

k Back to Load Metadata

g Select All

q Delete All

Table 3-15    Load Member Lists

Key Action

m Member List file

l Load

s Scan

k Back to Load member Lists

Table 3-16    Load Rules

Key Action

m Rules file

l Load

s Scan

k Back to Load Rules

Table 3-17    Load Data

Key Action

l Load

s Scan

k Back to Load Data

Table 3-18    Load Journals

Key Action

m Journals file

l Load

k Back to Load Journals

Chapter 3
Financial Performance Management
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Table 3-19    Load Intercompany Transactions

Key Action

l Load

s Scan

k Back to Load Intercompany Transactions

Table 3-20    Extract Security

Key Action

m Extract

k Back to Extract Security

Table 3-21    Extract Metadata

Key Action

m Extract

k Back to Extract Metadata

g Select All

q Deselect All

Table 3-22    Extract Member Lists

Key Action

k Extract

Table 3-23    Extract Rules

Key Action

k Extract

Table 3-24    Extract Data

Key Action

m Extract

k Back to Extract Data

Table 3-25    Extract Journals

Key Action

m Extract

k Back to Extract Journals
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Table 3-26    Extract Intercompany Transactions

Key Action

m Extract

k Back to Extract Intercompany Transactions

Table 3-27    Application Tasks

Key Action

c Create application

r Register application

l Close

n Create Classic application: Navigate

a Create Classic application: Administer

c Classic Application Administration

c Consolidation Administration

c Create Classic application

d Delete Application

r Register Application

t Consolidation System Messages

o Consolidation users on system

v Manage Consolidation Servers and Applications

Table 3-28    Navigation task shortcut keys

Key Action

b Browser View Tree

0 (zero) Browser View List

j Project View

TAB key Views Navigate

Up and Down arrow keys Navigate through the Tree and List

Right and left arrow keys Expand and collapse the tree nodes

Spacebar Views: Select nodes

Table 3-29    User Preferences

Key Action

s Save

r Reset

Table 3-30    Member Selector

Key Action

o OK

l Cancel

\ Previous
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Table 3-30    (Cont.) Member Selector

Key Action

/ Next

- (dash) Textbox selected value

k Textbox top name

g Dropdown selector

' (apostrophe) Description

= Filter

i Validate selected value

y Clear selected value

u Find previous value

v Find next value

Shift + { Move selected item up

Shift + } Move selected item down

x + Tab Tree

; + Tab List

' (apostrophe) f(x), Selects current POV member hierarchy

, (comma) Cur, Selects current POV member

Shift + ? Sort

Table 3-31    POV Bar

Key Action

! Scenario

@ Year

# Period

$ View

% Entity

^ Value

& Account

* ICP

( Custom1

) Custom2

- Custom3

+ Custom4

Table 3-32    Calendar Tasks

Key Action

r Previous year

p Previous month

n Next month

x Next year

l Close calendar
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Table 3-33    Data Grid and Data Forms Tasks

Key Action

For data grid: Space. Data Forms are activated by
default.

Activate

Right arrow. For Data Forms, right arrow and Tab. Move to next cell in a row

Left arrow. For Data Forms: left arrow, Shift and
Tab

Move to previous cell in a row

Down arrow Move to next row

Up arrow Move to previous row

Ctrl + Home - The Data grid works only on the
displayed cells. Data forms work on all the data.

Move to top left cell

Ctrl + End - The Data grid works only on the
displayed cells. Data forms work on all the data.

Move to right bottom cell

HOME First cell in a row

END Last cell in a row

PAGEUP First cell in a column

PAGEDOWN Last cell in a column

F2 Enter edit mode in a cell

Enter Finish editing and move one cell down

Tab Finish editing and move one cell right

Data Grids: F9 Access context menu

Data Forms: F9 Access context menu

Data Grids: unavailable Row header context menu in Linked form and
preview form

Data Forms: w Row header context menu in Linked form and
preview form

Data Grids: unavailable Column header context menu in Linked form and
preview form

Data Forms: n Column header context menu in Linked form and
preview form

Data Grids: unavailable Lines context menu in Linked form and preview
form

Data Forms: o Lines context menu in Linked form and preview
form

Table 3-34    Document Manager

Key Action

1 All

2 Tasklists

3 Data Forms

4 Data Grids

5 Report

6 Link

7 Related Content

8 Custom documents

l New folder

p Print
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Table 3-34    (Cont.) Document Manager

Key Action

w New task list

w New data grid

w New data form

w New link

w New web form

w New report

i Edit

p Add to Favorites

e Delete

o Load

x Extract

q Show private documents

q Hide private documents

s Browse

m Load local reports: Select report

o Load local reports: Open

p Load local reports: Print

o New Folder: OK

l New Folder: Cancel

o Load Documents: OK

l Load Documents: Cancel

y Load Documents: Finished

x Load Documents: Load More Files

o Save Documents: OK

l Save Documents: Cancel

Table 3-35    Create Intercompany Reports

Key Action

w Print/Preview

m Save remote

s Save local

l Close

q Entity Selector

+ Add Entity Account

- Remove Entity Account

y Add Partner Account

x Remove Partner Account

Table 3-36    Create Explore Data Reports

Key Action

w Print/preview

m Save remote
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Table 3-36    (Cont.) Create Explore Data Reports

Key Action

s Save local

x View as XML

para View as RPT

l Close

Table 3-37    Report Options

Key Action

o Print report options: OK

l Print report options: Cancel

o Overrides for Intercompany reports: OK

l Overrides for Intercompany reports: Cancel

g Overrides for Intercompany reports: Entity selector

q Overrides for Intercompany reports: Partner
selector

o Overrides for Journal reports: OK

Table 3-38    Favorites

Key Action

m Remove

l Clean

Table 3-39    Related Content

Key Action

i Resource document

v Select resource document

u Clear document

g Open document

k Select resource server

x Tree

y Client area

s Save

l Close

Table 3-40    Links

Key Action

w View

s Save

l Cancel
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Table 3-41    Tasklists

Key Action

k Add to Tasklist

l Return to Tasklist

Shift + '+' (plus sign) Select All

s Manage Tasklist: Save

l Manage Tasklist: Close

u Manage Tasklist: Move up

w Manage Tasklist: Move down

k Manage Tasklist: Select list of tasks

m Manage Tasklist: This is my default tasklist

c, a Actions Menu: Add

c, r Actions Menu: Remove

Table 3-42    Data Grid Tasks

Key Action

a Cell Line Item Detail: Add

o Cell Line Item Detail: OK

l Cell Line Item Detail: Cancel

o Cell Information: OK

a Cell Text: Attach

t Cell Text: Detach

o Cell Text: OK

l Cell Text: Cancel

x Attach Documents: Attach

y Attach Documents: Cancel

1 Grid Settings: Layout

2 Grid Settings: Display Options

o Grid Settings: OK

l Grid Settings: Cancel

a Manage Process: Attach

t Manage Process: Detach

o Manage Process: OK

l Manage Process: Cancel

l Cell History: Close

l Source or Destination Transaction: Close window

r Entity Details: Refresh

l Close Entity Details window

Table 3-43    Process Intercompany Transactions - Main Window

Key Action

\ Previous

/ Next

g Entity
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Table 3-43    (Cont.) Process Intercompany Transactions - Main Window

Key Action

q Partner

u Update

+ Select All

Table 3-44    Process Intercompany Transactions - Actions menu

Key Action

c, a Alert

c, n New

c, e Edit

c, e, t Edit transaction

c, e, s Set reason code

c, d Delete

c, d, s Delete selected

c, d, a Delete All

c, m Match

c, m, a Auto match

c, m, m Manual match

c, m, u Unmatch selected

c, m, i Unmatch all

c, p Post

c, p, s Post selected

c, p, l Post all

c, u Unpost

c, u, s Unposted selected

c, u, l Unpost all

c, f Filter

c, f, c Column

c, f, r Row

c, r Report

c, r, i Report by ID

c, r, a Report by Account

c, r, t Report by Transaction

Table 3-45    Process Intercompany Transaction Tasks

Key Action

[ New/Edit: Calendar

w New/Edit: New

s New/Edit: Save

k New/Edit: Reset

l New/Edit: Close

I New/Edit: Pick members

s Set reason code
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Table 3-45    (Cont.) Process Intercompany Transaction Tasks

Key Action

l Cancel reason code

Table 3-46    Manual Match Intercompany Transactions

Key Action

g Entity

q Partner

k Add Accounts

x Remove Accounts

e Add Matching Accounts

u Remove Matching Accounts

+ Select All Entity Accounts

- Select All Partner Accounts

m Match

s Save as Template

l Close

Table 3-47    Auto Match Intercompany Transactions

Key Action

g Entity

q Partner

k Add Accounts

x Remove Accounts

d Add Matching Accounts

u Remove Matching Accounts

+ Select All Entity Accounts

- Select All Partner Accounts

m Match

s Save as Template

l Close

Table 3-48    Unmatch Intercompany Transactions

Key Action

u Unmatch

l Close

k Select all

c Clear all
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Table 3-49    Intercompany Transactions - Filter Columns

Key Action

u Restore defaults

l Close

k Display column list multiselect

e Selected column list multiselect

\ Add selected

/ Remove selected

p Move up

o Move down

c, s Actions menu: Sort options

c, s, n Actions submenu: No sort

c, s, a Actions submenu: Ascending

c, s, d Actions submenu: Descending

c, d Actions menu: Display options

c, d, l Actions submenu: Label

c, d, d Actions submenu: Description

c, d, b Actions submenu: Both

Table 3-50    Intercompany Transactions - Filter Rows

Key Action

4 Entity selector

5 Partner selector

6 Entity account selector

7 Partner account selector

8 Start Calendar

9 End Calendar

u Restore Defaults

l Close

Table 3-51    Intercompany Transactions - General Menu

Key Action

w Print/preview

m Save remote

s Transaction ID - General Save local

l Close

g Entity selector

q Partner selector

No access keys Display Options
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Table 3-52    Intercompany Transaction Accounts

Key Action

w Account - General: Print/preview

m Account - General: Save remote

s Account - General: Save local

l Account - General: Close

g Account - General: Entity selector

q Account - General: Partner selector

No access keys Account - General: Display options

+ Add accounts

k Add Accounts checkbox

- Matching Accounts

x Remove Accounts

e Add Matching Accounts

u Remove Matching Accounts

Table 3-53    Intercompany Transactions - Setting Columns

Kay Action

u Restore defaults

l Close

k Display column list multiselect

e Selected column list multiselect

\ Add selected

/ Remove selected

p Move up

o Move down

c, s Actions menu: Sort options

c, s. n Actions menu: No sort

c, s, o Actions menu: Ascending

c, s, d Actions menu: Descending

c, d Actions menu: Display options

c, d, l Actions menu: Label

c, d, d Actions menu: Description

Table 3-54    Intercompany Transactions - Setting Rows

Key Action

4 Entity selector

5 Partner selector

6 Entity account selector

7 Partner account selector

8 Calendar 1

9 Cakebdar 2

u Restore defaults

q Close
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Table 3-55    Intercompany Transactions Alert Options

Key Action

s Send Transaction Alerts

l Cancel Transaction Alerts

Table 3-56    Monitor Intercompany Transactions

Key Action

g Entity Search

u Update

1 (numeric) Process Status column

2 Lock Status column

\ Previous

/ Next

Shift + '+' (plus sign) Select All

c, t Action menu: Alert

c, u Action menu: Summary

l Close Monitor Summary window

l Close Monitor Detail window

p Open Intercompany Transaction Period

l Close Intercompany Transaction Period

s Save Period Settings

l Close Period Status

k Lock Intercompany Entities

u Unlock Intercompany Entities

Shift + '+' (plus sign) Lock or Unlock Intercompany Entities: Select All

l Lock or Unlock Intercompany Status: Close window

Table 3-57    Manage Ownership

Key Action

k Select All

I Fill

p Display Options

o Calculate Ownership

s Save

c Reset

o Display Options: OK

l Display Options: Cancel

c Calculate Ownership: Calculate

l Calculate Ownership: Cancel
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Table 3-58    Copy Data

Key Action

c Copy Data

k Back to Copy Data

2 Clear Data

3 Delete Invalid Records

l Copy Data

! POV: Source Scenario

@ POV: Source Year

# POV: Source Period

! POV: Destination Scenario

@ POV: Destination Year

# POV: Destination Period

% POV: Copy Members Entity

& POV: Copy Members Account

Table 3-59    Clear Data

Key Action

1 Copy Data

2 Clear Data

3 Delete Invalid Records

c Clear Data

k Back to Clear Data

! POV: Scenario

@ POV: Year

# POV: Period

% POV: Entity

& POV: Account

Table 3-60    Delete Invalid Records

Key Action

1 Copy Data

2 Clear Data

3 Delete Invalid Records

d Delete Invalid Records

s Scan Only

k Back to Delete Invalid Records

Table 3-61    Process Control Tasks

Key Task

Same as data grids Process Control Window from Data Grid

a Process Control Window: Attach
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Table 3-61    (Cont.) Process Control Tasks

Key Task

t Process Control Window: Detach

x Process Control Window: Start, Promote, Sub mit,
Approve, Publish, Sign Off, Reject

l Error condition popup: Close

s Error condition popup: Show Details

o Options: OK

l Options: Cancel

l Process Status Summary: Close window

u Validation Detail: Update

l Validation Detail: Close window

l Process Flow History: Close window

l Calculation Status Summary: Close window

o Non-Phased Submissions: OK

l Non-Phased Submissions: Cancel

o Phased Submissions Rows: OK

l Phased Submissions Rows: Cancel

2 Phased Submissions Rows: Columns

o Phased Submissions Columns: OK

l Phased Submissions Columns: Cancel

l Phased Submissions Columns: Rows

2 Phased Submissions Columns: Columns

Accessibility not supported Main Manage Submission Phases Page from Data
Grids

o Show Unassigned Groups: OK

o Process Control Advanced Options: OK

l Process Control Advanced Options: Cancel

Table 3-62    Equity Pickup Tasks

Key Action

\ Previous

/ Next

1 Sort on Level column

2 Sort on Owner column

3 Sort on Owned column

4 Sort on %EPU column

5 Sort on Status column

c, f Actions menu: Filter

c, r Actions menu: Refresh

c, l Actions menu: Calculate

c, l, r Actions submenu: Run EPU

c, l, f Actions submenu: Force EPU

c, p Actions menu: Print Report

c, p, u Actions submenu: Full Report
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Table 3-62    (Cont.) Equity Pickup Tasks

Key Action

c, p, i Actions submenu: Filtered Report

g Filter: Owner Search

q Filter: Owned Search

o Filter: OK

l Filter: Cancel

Accessibility is not supported for reports. Reports

Table 3-63    Data Forms - Main Form Page

Key Action

~ Main form: Read current POV

F2 Enter edit mode in a cell to enter cell text

c, s Actions: Submit

c, r Actions: Refresh

c, c Actions: Calculate

c, t Actions: Force Calculate

c, x Actions: Cell Text

c, i Actions: Instructions

c, p Actions: Print

c, m Actions: Import from Excel

c, 3 Actions: Export to Excel 2003

c, 7 Actions: Export to Excel 2007

s Linked form, Preview form: Submit

r Linked form, Preview form: Refresh

c Linked form, Preview form: Calculate

f Linked form, Preview form: Force calculate

t Linked form, Preview form: Cell text

Table 3-64    Data Form Suppression Options

Key Action

c, w Suppress Rows

c, w, n Suppress rows: None

c, w, d Suppress rows: Nodata

c, w, z Suppress rows: Zero

c, w, o Suppress rows: Nodata and Zero

c, w, i Suppress rows: Invalid

c, w, a Suppress rows: Invalid and Nodata

c, w, e Suppress rows: Invalid and Zero

c, w, r Suppress rows: Invalid and Nodata and Zero

c, n Suppress columns

c, n, n Suppress columns None

c, n, d Suppress columns Nodata

c, n, z Suppress columns Zero
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Table 3-64    (Cont.) Data Form Suppression Options

Key Action

c, n, o Suppress columns Nodata and Zero

c, n, i Suppress columns Invalid

c, n, a Suppress columns Invalid and Nodata

c, n, e Suppress columns Invalid and Zero

c, n, r Suppress columns Invalid and Nodata and Zero

c, o Suppress lines

c, o, n Suppress lines None

c, o, d Suppress lines Nodata

c, o, z Suppress lines Zero

c, o, o Suppress lines Nodata and Zero

c, o, i Suppress lines Invalid

c, o, a Suppress lines Invalid and Nodata

c, o, e Suppress lines Invalid and Zero

c, o, r Suppress lines Invalid and Nodata and Zero

Table 3-65    Data Forms - Line Item

Key Action

s Save

r Refresh

l Close

w New entry

e Delete row

c Clear row

Shift + '+' (plus sign) Select All

Up and Down arrows Move focus to cell on which the context menu is to
be displayed and click F9

Table 3-66    Data Form - Cell Text

Key Action

a Attach

t Detach

o OK

l Cancel

l Cell Adjustments: Close window

o Cell Adjustments: OK

Table 3-67    Data Form Tasks

Key Action

o Properties: OK

o Import from Excel: OK

l Import from Excel: Cancel
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Table 3-67    (Cont.) Data Form Tasks

Key Action

u Import from Excel: File Browse

l Instructions: Close

l View Definition: Close

Table 3-68    Data Forms - New

Key Action

1 Properties

2 POV

3 Columns

4 Rows

5 Details

6 Header

7 Script

Table 3-69    Data Form Properties

Key Action

s Save

r Reset

c Scan

l Preview

u Update

l Close

x Next

k Back

q POV: Searcg

q Columns or Rows: SearchCommon keys: see
Properties module.

Common keys see Properties module. Details and Headers

p Script: Print

o Script: More

e Script: Less

p Script Print page: Print

l Script Close print page

Table 3-70    Process Journals Main Window

Key Action

+ Check all

L Anchor (common for all rows) Journal Label

w New

o Open

e Delete
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Table 3-70    (Cont.) Process Journals Main Window

Key Action

I Filter

p Reports

c, s Submit

c, u Unsubmit

c, a Approve

c, r Reject

c, p Post

c, n Unpost

o New Journal window: OK

l New Journal window: Cancel

+ Open/Edit/New: Add row

y Open/Edit/New: Copy row

I Open/Edit/New: Paste row

m Select member

Select a cell and click F9 (only if journal is editable) Display context menu

w New

e Delete

s Save

x Reset

k Scan

p Print

l Close

Table 3-71    Journal Filters - Columns and Rows

Key Action

1 Column

2 Filter

o OK

l Cancel

3 Restore defaults

c Filter Rows: Select All

q Filter Rows: Entity search

p Filter Rows: Deselect All

Table 3-72    Journal Report Properties

Key Action

p Print/preview

m Save remote

s Save local

l Close

l Properties

2 Columns
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Table 3-72    (Cont.) Journal Report Properties

Key Action

3 Filter

Table 3-73    Journal Reports - Setting Columns

Key Action

p Print/preview

m Save remote

s Save local

l Close

l Properties

2 Columns

3 Filter

+ Repeat

t Totals

Table 3-74    Journal Reports - Setting Rows

Key Action

e Restore defaults

1 Properties

2 Columns

3 Filter

p Print/preview

m Save remote

s Save local

l Close

Table 3-75    Journal Templates

Key Action

1 Standard

2 Recurring

w New

o Open

e Delete

f Filter

r Reports

+ Check All

\ Anchor (common for all rows) - Link to journal
labels

w New or Open: New

e New or Open: Delete

s New or Open: Save

x New or Open: Reset
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Table 3-75    (Cont.) Journal Templates

Key Action

g New or Open: Generate

p New or Open: Print

l New or Open: Close

+ New or Open: Add rows

y New or Open: Copy rows

i New or Open: Paste rows

m New or Open: Select members

Move the focus to any cell and click F9. New or Open: Enable context menu on line items

Table 3-76    Journals - Filter Columns and Rows

Key Action

e Filter Columns: Restore defaults

1 Filter Columns: Columns

2 Filter Columns: Filter

o Filter Columns: OK

l Filter Columns: Cancel

e Filter Rows: Restore defaults

1 Filter Rows: Columns

2 Filter Rows: Filter

o Filter Rows: OK

l Filter Rows: Cancel

Table 3-77    Journals - Manage Periods

Key Action

p Manage Periods: Open period

l Manage Periods: Close period

Table 3-78    Journals - Manage Groups

Key Action

g Add groups

m Remove groups

v Remove all

+ Select all

Table 3-79    Journals - New

Key Action

Up and Down arrows to select items Move focus to a cell on the context menu to be
displayed and click F9.

Chapter 3
Financial Performance Management

3-28



Table 3-79    (Cont.) Journals - New

Key Action

Up and Down arrows to select items New Template: Move focus to a cell on the context
menu to be displayed and click F9.

Table 3-80    Security - Users and Groups

Key Action

s Select Users and Groups: Search

w Show all

1 Select Users and Groups: Select

3 Select all

2 Select Users and Groups: Remove

3 Select Users and Groups: Remove all

g Help

k Back

x Next

Table 3-81    Security - Select Classes

Key Action

1 Select

3 Select all

2 Remove

4 Remove all

b Add

o Delete

Table 3-82    Security Assign Access

Key Action

s Save

l Cancel

t Set

Table 3-83    Security Alerts

Key Action

p Pivot

e Add Alert

r Remove alert
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Table 3-84    Security Reports

Key Action

n Launch Security Reports

r Export Security Reports

Tax Provision
Related Topics

• Tax Provision Accessibility Features

• Tax Provision Keyboard Equivalents

Tax Provision Accessibility Features
Tab Indexes are provided for Groupboxes, TextBoxes, and Buttons.

Note:

The JAWS screen reader can announce the number of items in a group box if you
click Alt and the Up arrow key.

Abbreviations such as "POV" for Point of View are used across screens. Screen readers read
them as "POV." To add abbreviation equivalents in the Screen Reader dictionary, such as
replacing "POV" with "Point of View," refer to your screen reader documentation.

All reports that use the HFM_format style can be accessed using JAWS table reading
commands.

Tax Provision Keyboard Equivalents
These sections describe the keyboard equivalents for Oracle Hyperion Tax Provision
applications by module.

To use shortcut keys, select Alt, then the keyboard shortcut, and then press Enter. For
example, to view logged-in users, select Alt+i, then Enter.

For multiple selections, you can use Shift+F8. When this mode is enabled, you can move up or
down the list of choices and press the spacebar to select multiple items, or press the spacebar
again to deselect an item.

You can use Alt+Z as a shortcut key to go to the beginning of any page. You can also use
Alt+Z to navigate to a floating frame when loading a page. In certain cases, when a page is
refreshed as a result of an action, the focus goes to the top of the Tax Provision content area.
You can navigate using Tab or shortcut keys.

File Menu

Use these keyboard shortcuts from the File menu. Select File (Alt + f), then New (n), and then
an option.
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Table 3-85    File New Menu Keyboard Shortcuts

Keys Action

g Data grid

f Data form

l Link

r Related Content

k Tasklist

For new System Reports, use these keyboard shortcuts from the File menu. Select File (Alt +
f), then New (n), then System Report (s), and then an option.

Table 3-86    System Report Menu Keyboard Shortcuts

Keys Action

I Intercompany

d Data grid

t Intercompany Matching template

n Intercompany transactions

c Intercompany Matching by Account

m Intercompany Matching by Transaction ID

View Menu

Use these keyboard shortcuts from the View menu. Select View (Alt + v), and then an option.

Table 3-87    View Menu Keyboard Shortcuts

Keys Action

m Advanced Mode

Administration Menu

These keyboard shortcuts are used in the Administration menu. Select Administration (Alt + a),
and then an option.

Table 3-88    Consolidation Application Administration

Keys Action

d Manage Documents

f Manage Favorites

s System Messages

u Users on System

r Manager Servers and Applications

k Task Audit

t Data Audit

i Running Tasks

x Extended Analytics

c Copy Document Link
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Table 3-88    (Cont.) Consolidation Application Administration

Keys Action

l Manage Taskflows

v View Taskflow Status

w Manage Smart View Providers

Navigating to the Application

Table 3-89    Application Navigation Shortcuts

Keys Action

Alt_z or Ctrl+F6 Tab iFrame- Main content area

Alt+q iFrame - Popups (when iFrame receives focus)

Alt+L Close popups

Alt+y Access contents of the selected tab page

Shortcut Keys by Module

Table 3-90    Users on System

Key Action

I Log out users

g Enable connections

o Disable connections

\ View disabled somponents

/ Enable (common for all rows)

Table 3-91    Manage Servers and Applications

Key Action

g Log out users

e Enable connections

s Disable Connections

I View disabled components

n Enable (common for all rows)

Table 3-92    System Messages

Key Action

I View system messages

[ Calendar start

] Calendar end

s Show Details

e Delete system messages

l Delete All system messages

+ Select All system messages
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Table 3-92    (Cont.) System Messages

Key Action

u Anchor tag for error details. Same for each row

\ Previous page

/ Next page

p Print Error Details page

l Close

Table 3-93    Running Tasks and popup menu

Key Action

I View Running Tasks

x Stop running task from popup menu

q Stop running task from popup menu

q From Running Task Log page, navigate to top

r Refresh

l Close

Table 3-94    Extended Analytics

Key Action

s Save template as

p Delete template

o Refresh template

c Create Star Schema

e Delete Star Schema

u Update Star Schema

s Save template

l Cancel

Table 3-95    Data Audit

Key Action

[ Start date

] End date

\ Previous

/ Next

Same as POV bar POV

I View

l Clear Log

x Export

Chapter 3
Financial Performance Management

3-33



Table 3-96    Task Audit

Key Actions

[ Start date

] End date

\ Previous

/ Next

I View

l Clear log

x Export

o OK in Task Audit Export page

Table 3-97    Load Security

Key Action

m Security file

l Load

k Back to Load Security

Table 3-98    Load Metadata

Key Action

m Metadata file

l Load

s Scan

k Back to Load Metadata

g Select All

q Delete All

Table 3-99    Load Member Lists

Key Action

m Member List file

l Load

s Scan

k Back to Load member Lists

Table 3-100    Load Rules

Key Action

m Rules file

l Load

s Scan

k Back to Load Rules
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Table 3-101    Load Data

Key Action

l Load

s Scan

k Back to Load Data

Table 3-102    Load Intercompany Transactions

Key Action

l Load

s Scan

k Back to Load Intercompany Transactions

Table 3-103    Extract Security

Key Action

m Extract

k Back to Extract Security

Table 3-104    Extract Metadata

Key Action

m Extract

k Back to Extract Metadata

g Select All

q Deselect All

Table 3-105    Extract Member Lists

Key Action

k Extract

Table 3-106    Extract Rules

Key Action

k Extract

Table 3-107    Extract Data

Key Action

m Extract

k Back to Extract Data
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Table 3-108    Extract Intercompany Transactions

Key Action

m Extract

k Back to Extract Intercompany Transactions

Table 3-109    Application Tasks

Key Action

c Create application

r Register application

l Close

n Create Classic application: Navigate

a Create Classic application: Administer

c Classic Application Administration

c Consolidation Administration

c Create Classic application

d Delete Application

r Register Application

t Consolidation System Messages

o Consolidation users on system

v Manage Consolidation Servers and Applications

Table 3-110    Navigation task shortcut keys

Key Action

b Browser View Tree

0 (zero) Browser View List

j Project View

TAB key Views Navigate

Up and Down arrow keys Navigate through the Tree and List

Right and left arrow keys Expand and collapse the tree nodes

Spacebar Views: Select nodes

Table 3-111    User Preferences

Key Action

s Save

r Reset

Table 3-112    Member Selector

Key Action

o OK

l Cancel

\ Previous
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Table 3-112    (Cont.) Member Selector

Key Action

/ Next

- (dash) Textbox selected value

k Textbox top name

g Dropdown selector

' (apostrophe) Description

= Filter

i Validate selected value

y Clear selected value

u Find previous value

v Find next value

Shift + { Move selected item up

Shift + } Move selected item down

x + Tab Tree

; + Tab List

' (apostrophe) f(x), Selects current POV member hierarchy

, (comma) Cur, Selects current POV member

Shift + ? Sort

Table 3-113    POV Bar

Key Action

! Scenario

@ Year

# Period

$ View

% Entity

^ Value

& Account

* ICP

( Custom1

) Custom2

- Custom3

+ Custom4

Table 3-114    Calendar Tasks

Key Action

r Previous year

p Previous month

n Next month

x Next year

l Close calendar
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Table 3-115    Data Grid and Data Forms Tasks

Key Action

For data grid: Space. Data Forms are activated by
default.

Activate

Right arrow. For Data Forms, right arrow and Tab. Move to next cell in a row

Left arrow. For Data Forms: left arrow, Shift and
Tab

Move to previous cell in a row

Down arrow Move to next row

Up arrow Move to previous row

Ctrl + Home - The Data grid works only on the
displayed cells. Data forms work on all the data.

Move to top left cell

Ctrl + End - The Data grid works only on the
displayed cells. Data forms work on all the data.

Move to right bottom cell

HOME First cell in a row

END Last cell in a row

PAGEUP First cell in a column

PAGEDOWN Last cell in a column

F2 Enter edit mode in a cell

Enter Finish editing and move one cell down

Tab Finish editing and move one cell right

Data Grids: F9 Access context menu

Data Forms: F9 Access context menu

Data Grids: unavailable Row header context menu in Linked form and
preview form

Data Forms: w Row header context menu in Linked form and
preview form

Data Grids: unavailable Column header context menu in Linked form and
preview form

Data Forms: n Column header context menu in Linked form and
preview form

Data Grids: unavailable Lines context menu in Linked form and preview
form

Data Forms: o Lines context menu in Linked form and preview
form

Table 3-116    Document Manager

Key Action

1 All

2 Tasklists

3 Data Forms

4 Data Grids

5 Report

6 Link

7 Related Content

8 Custom documents

l New folder

p Print
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Table 3-116    (Cont.) Document Manager

Key Action

w New task list

w New data grid

w New data form

w New link

w New web form

w New report

i Edit

p Add to Favorites

e Delete

o Load

x Extract

q Show private documents

q Hide private documents

s Browse

m Load local reports: Select report

o Load local reports: Open

p Load local reports: Print

o New Folder: OK

l New Folder: Cancel

o Load Documents: OK

l Load Documents: Cancel

y Load Documents: Finished

x Load Documents: Load More Files

o Save Documents: OK

l Save Documents: Cancel

Table 3-117    Create Intercompany Reports

Key Action

w Print/Preview

m Save remote

s Save local

l Close

q Entity Selector

+ Add Entity Account

- Remove Entity Account

y Add Partner Account

x Remove Partner Account

Table 3-118    Create Explore Data Reports

Key Action

w Print/preview

m Save remote
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Table 3-118    (Cont.) Create Explore Data Reports

Key Action

s Save local

x View as XML

para View as RPT

l Close

Table 3-119    Report Options

Key Action

o Print report options: OK

l Print report options: Cancel

o Overrides for Intercompany reports: OK

l Overrides for Intercompany reports: Cancel

g Overrides for Intercompany reports: Entity selector

q Overrides for Intercompany reports: Partner
selector

Table 3-120    Favorites

Key Action

m Remove

l Clean

Table 3-121    Related Content

Key Action

i Resource document

v Select resource document

u Clear document

g Open document

k Select resource server

x Tree

y Client area

s Save

l Close

Table 3-122    Links

Key Action

w View

s Save

l Cancel
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Table 3-123    Tasklists

Key Action

k Add to Tasklist

l Return to Tasklist

Shift + '+' (plus sign) Select All

s Manage Tasklist: Save

l Manage Tasklist: Close

u Manage Tasklist: Move up

w Manage Tasklist: Move down

k Manage Tasklist: Select list of tasks

m Manage Tasklist: This is my default tasklist

c, a Actions Menu: Add

c, r Actions Menu: Remove

Table 3-124    Data Grid Tasks

Key Action

a Cell Line Item Detail: Add

o Cell Line Item Detail: OK

l Cell Line Item Detail: Cancel

o Cell Information: OK

a Cell Text: Attach

t Cell Text: Detach

o Cell Text: OK

l Cell Text: Cancel

x Attach Documents: Attach

y Attach Documents: Cancel

1 Grid Settings: Layout

2 Grid Settings: Display Options

o Grid Settings: OK

l Grid Settings: Cancel

a Manage Process: Attach

t Manage Process: Detach

o Manage Process: OK

l Manage Process: Cancel

l Cell History: Close

l Source or Destination Transaction: Close window

r Entity Details: Refresh

l Close Entity Details window

Table 3-125    Process Intercompany Transactions - Main Window

Key Action

\ Previous

/ Next

g Entity
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Table 3-125    (Cont.) Process Intercompany Transactions - Main Window

Key Action

q Partner

u Update

+ Select All

Table 3-126    Process Intercompany Transactions - Actions menu

Key Action

c, a Alert

c, n New

c, e Edit

c, e, t Edit transaction

c, e, s Set reason code

c, d Delete

c, d, s Delete selected

c, d, a Delete All

c, m Match

c, m, a Auto match

c, m, m Manual match

c, m, u Unmatch selected

c, m, i Unmatch all

c, p Post

c, p, s Post selected

c, p, l Post all

c, u Unpost

c, u, s Unposted selected

c, u, l Unpost all

c, f Filter

c, f, c Column

c, f, r Row

c, r Report

c, r, i Report by ID

c, r, a Report by Account

c, r, t Report by Transaction

Table 3-127    Process Intercompany Transaction Tasks

Key Action

[ New/Edit: Calendar

w New/Edit: New

s New/Edit: Save

k New/Edit: Reset

l New/Edit: Close

I New/Edit: Pick members

s Set reason code
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Table 3-127    (Cont.) Process Intercompany Transaction Tasks

Key Action

l Cancel reason code

Table 3-128    Manual Match Intercompany Transactions

Key Action

g Entity

q Partner

k Add Accounts

x Remove Accounts

e Add Matching Accounts

u Remove Matching Accounts

+ Select All Entity Accounts

- Select All Partner Accounts

m Match

s Save as Template

l Close

Table 3-129    Auto Match Intercompany Transactions

Key Action

g Entity

q Partner

k Add Accounts

x Remove Accounts

d Add Matching Accounts

u Remove Matching Accounts

+ Select All Entity Accounts

- Select All Partner Accounts

m Match

s Save as Template

l Close

Table 3-130    Unmatch Intercompany Transactions

Key Action

u Unmatch

l Close

k Select all

c Clear all
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Table 3-131    Intercompany Transactions - Filter Columns

Key Action

u Restore defaults

l Close

k Display column list multiselect

e Selected column list multiselect

\ Add selected

/ Remove selected

p Move up

o Move down

c, s Actions menu: Sort options

c, s, n Actions submenu: No sort

c, s, a Actions submenu: Ascending

c, s, d Actions submenu: Descending

c, d Actions menu: Display options

c, d, l Actions submenu: Label

c, d, d Actions submenu: Description

c, d, b Actions submenu: Both

Table 3-132    Intercompany Transactions - Filter Rows

Key Action

4 Entity selector

5 Partner selector

6 Entity account selector

7 Partner account selector

8 Start Calendar

9 End Calendar

u Restore Defaults

l Close

Table 3-133    Intercompany Transactions - General Menu

Key Action

w Print/preview

m Save remote

s Transaction ID - General Save local

l Close

g Entity selector

q Partner selector

No access keys Display Options
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Table 3-134    Intercompany Transaction Accounts

Key Action

w Account - General: Print/preview

m Account - General: Save remote

s Account - General: Save local

l Account - General: Close

g Account - General: Entity selector

q Account - General: Partner selector

No access keys Account - General: Display options

+ Add accounts

k Add Accounts checkbox

- Matching Accounts

x Remove Accounts

e Add Matching Accounts

u Remove Matching Accounts

Table 3-135    Intercompany Transactions - Setting Columns

Kay Action

u Restore defaults

l Close

k Display column list multiselect

e Selected column list multiselect

\ Add selected

/ Remove selected

p Move up

o Move down

c, s Actions menu: Sort options

c, s. n Actions menu: No sort

c, s, o Actions menu: Ascending

c, s, d Actions menu: Descending

c, d Actions menu: Display options

c, d, l Actions menu: Label

c, d, d Actions menu: Description

Table 3-136    Intercompany Transactions - Setting Rows

Key Action

4 Entity selector

5 Partner selector

6 Entity account selector

7 Partner account selector

8 Calendar 1

9 Cakebdar 2

u Restore defaults

q Close
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Table 3-137    Intercompany Transactions Alert Options

Key Action

s Send Transaction Alerts

l Cancel Transaction Alerts

Table 3-138    Monitor Intercompany Transactions

Key Action

g Entity Search

u Update

1 (numeric) Process Status column

2 Lock Status column

\ Previous

/ Next

Shift + '+' (plus sign) Select All

c, t Action menu: Alert

c, u Action menu: Summary

l Close Monitor Summary window

l Close Monitor Detail window

p Open Intercompany Transaction Period

l Close Intercompany Transaction Period

s Save Period Settings

l Close Period Status

k Lock Intercompany Entities

u Unlock Intercompany Entities

Shift + '+' (plus sign) Lock or Unlock Intercompany Entities: Select All

l Lock or Unlock Intercompany Status: Close window

Table 3-139    Manage Ownership

Key Action

k Select All

I Fill

p Display Options

o Calculate Ownership

s Save

c Reset

o Display Options: OK

l Display Options: Cancel

c Calculate Ownership: Calculate

l Calculate Ownership: Cancel
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Table 3-140    Copy Data

Key Action

c Copy Data

k Back to Copy Data

2 Clear Data

3 Delete Invalid Records

l Copy Data

! POV: Source Scenario

@ POV: Source Year

# POV: Source Period

! POV: Destination Scenario

@ POV: Destination Year

# POV: Destination Period

% POV: Copy Members Entity

& POV: Copy Members Account

Table 3-141    Clear Data

Key Action

1 Copy Data

2 Clear Data

3 Delete Invalid Records

c Clear Data

k Back to Clear Data

! POV: Scenario

@ POV: Year

# POV: Period

% POV: Entity

& POV: Account

Table 3-142    Delete Invalid Records

Key Action

1 Copy Data

2 Clear Data

3 Delete Invalid Records

d Delete Invalid Records

s Scan Only

k Back to Delete Invalid Records

Table 3-143    Process Control Tasks

Key Task

Same as data grids Process Control Window from Data Grid

a Process Control Window: Attach
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Table 3-143    (Cont.) Process Control Tasks

Key Task

t Process Control Window: Detach

x Process Control Window: Start, Promote, Sub mit,
Approve, Publish, Sign Off, Reject

l Error condition popup: Close

s Error condition popup: Show Details

o Options: OK

l Options: Cancel

l Process Status Summary: Close window

u Validation Detail: Update

l Validation Detail: Close window

l Process Flow History: Close window

l Calculation Status Summary: Close window

o Non-Phased Submissions: OK

l Non-Phased Submissions: Cancel

o Phased Submissions Rows: OK

l Phased Submissions Rows: Cancel

2 Phased Submissions Rows: Columns

o Phased Submissions Columns: OK

l Phased Submissions Columns: Cancel

l Phased Submissions Columns: Rows

2 Phased Submissions Columns: Columns

Accessibility not supported Main Manage Submission Phases Page from Data
Grids

o Show Unassigned Groups: OK

o Process Control Advanced Options: OK

l Process Control Advanced Options: Cancel

Table 3-144    Equity Pickup Tasks

Key Action

\ Previous

/ Next

1 Sort on Level column

2 Sort on Owner column

3 Sort on Owned column

4 Sort on %EPU column

5 Sort on Status column

c, f Actions menu: Filter

c, r Actions menu: Refresh

c, l Actions menu: Calculate

c, l, r Actions submenu: Run EPU

c, l, f Actions submenu: Force EPU

c, p Actions menu: Print Report

c, p, u Actions submenu: Full Report
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Table 3-144    (Cont.) Equity Pickup Tasks

Key Action

c, p, i Actions submenu: Filtered Report

g Filter: Owner Search

q Filter: Owned Search

o Filter: OK

l Filter: Cancel

Accessibility is not supported for reports. Reports

Table 3-145    Data Forms - Main Form Page

Key Action

~ Main form: Read current POV

F2 Enter edit mode in a cell to enter cell text

c, s Actions: Submit

c, r Actions: Refresh

c, c Actions: Calculate

c, t Actions: Force Calculate

c, x Actions: Cell Text

c, i Actions: Instructions

c, p Actions: Print

c, m Actions: Import from Excel

c, 3 Actions: Export to Excel 2003

c, 7 Actions: Export to Excel 2007

s Linked form, Preview form: Submit

r Linked form, Preview form: Refresh

c Linked form, Preview form: Calculate

f Linked form, Preview form: Force calculate

t Linked form, Preview form: Cell text

Table 3-146    Data Form Suppression Options

Key Action

c, w Suppress Rows

c, w, n Suppress rows: None

c, w, d Suppress rows: Nodata

c, w, z Suppress rows: Zero

c, w, o Suppress rows: Nodata and Zero

c, w, i Suppress rows: Invalid

c, w, a Suppress rows: Invalid and Nodata

c, w, e Suppress rows: Invalid and Zero

c, w, r Suppress rows: Invalid and Nodata and Zero

c, n Suppress columns

c, n, n Suppress columns None

c, n, d Suppress columns Nodata

c, n, z Suppress columns Zero
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Table 3-146    (Cont.) Data Form Suppression Options

Key Action

c, n, o Suppress columns Nodata and Zero

c, n, i Suppress columns Invalid

c, n, a Suppress columns Invalid and Nodata

c, n, e Suppress columns Invalid and Zero

c, n, r Suppress columns Invalid and Nodata and Zero

c, o Suppress lines

c, o, n Suppress lines None

c, o, d Suppress lines Nodata

c, o, z Suppress lines Zero

c, o, o Suppress lines Nodata and Zero

c, o, i Suppress lines Invalid

c, o, a Suppress lines Invalid and Nodata

c, o, e Suppress lines Invalid and Zero

c, o, r Suppress lines Invalid and Nodata and Zero

Table 3-147    Data Forms - Line Item

Key Action

s Save

r Refresh

l Close

w New entry

e Delete row

c Clear row

Shift + '+' (plus sign) Select All

Up and Down arrows Move focus to cell on which the context menu is to
be displayed and click F9

Table 3-148    Data Form - Cell Text

Key Action

a Attach

t Detach

o OK

l Cancel

l Cell Adjustments: Close window

o Cell Adjustments: OK

Table 3-149    Data Form Tasks

Key Action

o Properties: OK

o Import from Excel: OK

l Import from Excel: Cancel
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Table 3-149    (Cont.) Data Form Tasks

Key Action

u Import from Excel: File Browse

l Instructions: Close

l View Definition: Close

Table 3-150    Data Forms - New

Key Action

1 Properties

2 POV

3 Columns

4 Rows

5 Details

6 Header

7 Script

Table 3-151    Data Form Properties

Key Action

s Save

r Reset

c Scan

l Preview

u Update

l Close

x Next

k Back

q POV: Searcg

q Columns or Rows: SearchCommon keys: see
Properties module.

Common keys see Properties module. Details and Headers

p Script: Print

o Script: More

e Script: Less

p Script Print page: Print

l Script Close print page

Table 3-152    Security - Users and Groups

Key Action

s Select Users and Groups: Search

w Show all

1 Select Users and Groups: Select

3 Select all

2 Select Users and Groups: Remove
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Table 3-152    (Cont.) Security - Users and Groups

Key Action

3 Select Users and Groups: Remove all

g Help

k Back

x Next

Table 3-153    Security - Select Classes

Key Action

1 Select

3 Select all

2 Remove

4 Remove all

b Add

o Delete

Table 3-154    Security Assign Access

Key Action

s Save

l Cancel

t Set

Table 3-155    Security Alerts

Key Action

p Pivot

e Add Alert

r Remove alert

Table 3-156    Security Reports

Key Action

n Launch Security Reports

r Export Security Reports

Financial Reporting
Related Topics

• Financial Reporting Accessibility

• Financial Reporting Explore Repository Accessibility
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Financial Reporting Accessibility

Table 3-157    Accessibility for Financial Reporting

Key Action

CTRL+F6, followed by Tab To select a report in books and batches, if the focus is on the whole
list.

Enter To show a report, if the report is selected in the list.
Member Selection
Arrow keys Navigate through open members, if the focus is on option.
Enter To open or close tree node, if the focus is on the +/- sign or an open/

close folder image.
POV Bar
Tab Navigate through dimension buttons, if focus is on whole POV bar.
Enter Used to launch member selection dialog.
Import Financial
Reporting Documents
Dialog Box

In the Import dialog, when the focus is on a frame, press Ctrl+F6 to
enter a frame, then press Tab to select the first focusable item.

Annotations
Ctrl+B Access the area that displays annotation information associated with

the report.
Ctrl+Shift+2 Setting to adjust the size of the annotation pane and content area.

Hiding the annotation pane provides a larger content frame in
which to use . Select View, then View Annotations to hide/display the
Annotation pane.

Financial Reporting Explore Repository Accessibility
Related Topics

• Accessibility for Creating Books and Batches

• Accessibility for the Content Tab Bar

• Accessibility for the Favorites Manager Dialog Box

• Accessibility for Explore Tree and Explore List

• Accessibility for the File Dialog Box

• Accessibility for File Type Drop Down

• Accessibility Behaviors for General UI Elements

• Accessibility for Online Help

• Accessibility for the Properties Dialog Box

• Accessibility for the Show Columns Dialog Box

• Accessibility for Sidebar Icon List
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Accessibility for Creating Books and Batches

Table 3-158    Shortcut Keys for Creating Books and Batches

Key Action

Left side with items to be added to the selected list
Down Arrow When on any node, select the next node below the current one.

Selection does not wrap from the last node to the first.
Up Arrow When on any node, select the next node above the current one.

Selection does not wrap from the first node to the last.
Page Up When on any node, move to the last visible node on the

previous page; or, if there is no previous page, the first node on
the current page.

Page Down When on any node, move to the first visible node on the next
page; or, if there is no next page, the last node on the current
page.

Left Arrow When on any node, drill up to the folder node (parent of the
current node). When at the root node, nothing happens.

Ctrl+Up/Down Arrow When on any node, enable navigation without changing the
selection.

Ctrl+Space When on any node, select/clear the currently focused item.
Shift+Up/Down When on any node, select/clear a sequential list of items.
Ctrl+A When on any node, select all nodes.
Right Arrow When on a folder node, drill down into the folder and present

contents.
Right Arrow When on any node except the folder node, add item to the

selected list.
Right side with items in the
selected list
Down Arrow When on any node, select the next node below the current one.

Selection does not wrap from the first node to the last.
Up Arrow When on any node, select the node above the current one.

Selection does no wrap from the last node to the first.
Page Up When on any node, go to the last visible node on the previous

page; or, if there is no previous page, the first node on the
current page.

Page Down When on any node, go to the first visible node on the next page;
or, if there is no next page, the last node on the current page.

Left Arrow When on any node, remove the item from the selected list.
Move Up/Down arrow image
to change the item's order in
the list
Up/Down Arrow Select the item to move.
Tab to Up/Down Arrow Image Select an arrow to indicate whether to move the item up or

down.
Space Bar Activate moving the item up or down.

Accessibility for the Content Tab Bar
When focus is on the Content tab bar, selection focus is on the current tab, if any.
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Table 3-159    Content Tab Bar— Accessibility Keys

Keys Action

Right/Up
Arrows

When on any document content tab, the next tab to the right is selected. The
selection wraps from the rightmost tab to the leftmost.

Left/Down
Arrows

When on any document content tab, the next tab to the left is selected. The
selection wraps from the leftmost tab to the rightmost.

Accessibility for the Favorites Manager Dialog Box

Table 3-160    Shortcut Keys in the Favorites Manager Dialog Box

Keys Action

Grid
Up/Down/Left/
Right Arrows

Change current cell selection

Space Bar Check/clear cell

Accessibility for Explore Tree and Explore List

Table 3-161    Accessibility for the Explore Repository Tree and the Explore Repository
List

Key Action

Explore Tree
Up Arrow When on any node, select the node below the current one. Selection

does not wrap.
Down Arrow When on any node, select the node above the current one. Selection

does not wrap.
Page Up When on any node, move to the last visible node on the previous page;

or, if there is no previous page, the first node on the current page.
Page Down When on any node, move to the first visible node on the next page; or, if

there is no next page, the last node on the current page.
Right Arrow When on a folder node with a plus icon, expand the node.

When on a folder node with a minus icon, move to the next node.

Left Arrow When on a folder node with a plus icon, move up to the next expanded
folder.
When on a folder node with a minus icon, collapse the node.

Arrow Keys (left/
right/top/bottom)

The built-in keys for moving around the Explore Repository and
accessing different cells and rows in a grid or tree view.

Explore List
Up Arrow When on any node, select the node below the current one. Selection

does not wrap.
Down Arrow When on any node, select the node above the current one. Selection

does not wrap.
Page Up When on any node, move to the last visible node on the previous page;

or, if there is no previous page, the first node on the current page.
Page Down When on any node, move to the first visible node on the next page; or, if

there is no next page, the last node on the current page.

Chapter 3
Financial Reporting

3-55



Table 3-161    (Cont.) Accessibility for the Explore Repository Tree and the Explore
Repository List

Key Action

Ctrl+Up/Down Arrow When on any node, enable navigation without changing the current
selection.

Ctrl+Space When on any node, select/clear the currently focused item.
Ctrl+A When on any node, select all nodes.
Shift+Up/Down Arrow When on any node, select/clear the sequential list of items.
Enter When on a folder node, drill into the folder.

When on any node except a folder node, launch the item.

Arrow Keys (left/
right/top/bottom)

The built-in keys for moving around the Explore Repository and
accessing different cells and rows in a grid or tree view.

The following rules are applied when using the context menu key to display context menus in
the Explore Repository:

• If the left pane of the Explore Repository has focus, one of the following occurs:

– If the mouse pointer is over the selected item, then the context menu is displayed for
the selected item.

– If the mouse pointer is not over the selected item, then no context menu is displayed.

• If the right pane of the Explore Repository has focus, one of the following occurs:

– If the mouse pointer is over the selected item, then the context menu is displayed for
the selected item.

– If the mouse pointer is over a blank area, for example not pointing to any items, then
the context menu of the selected item in the left pane is displayed.

– If the mouse location is over any other area, then the context menu is not displayed.

Accessibility for the Favorites Manager Dialog Box

Table 3-162    Shortcut Keys in the Favorites Manager Dialog Box

Keys Action

Grid
Up/Down/Left/
Right Arrows

Change current cell selection

Space Bar Check/clear cell

Accessibility for the File Dialog Box

Table 3-163    Shortcut Keys in the File Dialog Box

Key Action

Up Arrow When on any node, select the node above the current one. Selection does not
wrap from the first node in the list to the last.

Down Arrow When on any node, select the node below the current one. Selection does not
wrap from the last node in the list to the first.
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Table 3-163    (Cont.) Shortcut Keys in the File Dialog Box

Key Action

Page Up When on any node, move to the last visible node on the previous page; or, if
there is no previous page, the last node on the current page.

Page Down When on any node, move to the first visible node on the next page; or, if there is
no next page, the last node on the current page.

Left Arrow When on any node, drill up to the folder node (parent of the current node). If
already at the root node, nothing happens.

Right Arrow When on a folder node, drill down into the folder and present contents.
Enter When on any node except the folder node, select the item.

Accessibility for File Type Drop Down
The following keyboard shortcuts are supported in the File Type drop-down:

Table 3-164    Type Drop-Down — Accessibility Keys

Keys Action

Down arrow Drop the menu
Arrow up or down Change selection
Enter Make selection

Accessibility Behaviors for General UI Elements
Listed below are specific keystrokes for User Interface (UI) elements, as well as expected
screen-reader behavior when a UI element has focus:

Table 3-165    User Interface Element Types

UI Element Action

Button Either Enter or Space activates the button, causing the same action as a left
click.

ComboBox • Up or down arrow keys display the popup menu and enable value
selection.

• Space or Enter selects an item.
• If editable, alphanumeric keys cause an edit.

Dialog • If the dialog has an accept button defined, press Enter to activate it.
• The dialog is modal and blocks all other keyboard events.

Content Area
(IFrame)

• Press Ctrl+F6 to enter a frame. You may need to press Tab to select the first
focusable item.

• Press Ctrl+Shift+F6 to exit the frame content area and return focus to the
frame.
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Table 3-165    (Cont.) User Interface Element Types

UI Element Action

List • The up or down arrow keys move selection focus up or down through the
list elements. The selection is continually updated.

• Ctrl+Up or Ctrl+Down moves focus up or down without changing the
current selection. Press Spacebar to add the item to the selection.

• Shift+Up or Shift+Down key moves focus up or down and adds the item
with focus to the selection.

Note: If the list supports only a single selection, the Ctrl and Shift modifiers
have no effect.

Tab Bar Left or right arrow key moves selection focus and selects the new tab
immediately. Selection focus wraps around the ends of the tab bar.

Text Field • If editable, alphanumeric keys cause an edit.
• Pressing Tab moves focus to the next element in tab order. Tab cannot be

entered as a character in the text field.
Tree The left and right arrow keys collapse or expand the current node if it has

children. If it has no children, there is no effect. The expansion is not recursive.
However, if the tree is capable of remembering the previous expansion state of
any subnodes, it should do so.

Accessibility for Online Help

Table 3-166    Online Help Keyboard Shortcuts

Shortcut Description

Ctrl+Shift+1 Open and move focus to the Contents tab.
Ctrl+Shift+2 Open and move focus to the Index tab.
Ctr+Shift+3 Open and move focus to the Search tab.
Ctrl+Shift+4 Move focus to the content frame, which is the frame that contains

help topics.

Accessibility for the Properties Dialog Box
The following keyboard shortcuts are supported for the sidebar icon list for the File menu
Preferences and Properties options.

Table 3-167    Sidebar Icon List — Accessibility Keys

Keys Action

Tab/Shift+Tab Navigate up/down the items in the list.
Space Bar Select the item in the list that has focus.

Accessibility for the Show Columns Dialog Box

Table 3-168    Shortcut Keys in the Show Columns Dialog Box

Key Action

Grid
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Table 3-168    (Cont.) Shortcut Keys in the Show Columns Dialog Box

Key Action

Up/Down Arrow Change selection
Space Bar Check/clear the check box. Uncheck to hide the selected column in the

Explore Repository list.
Move item up/down
image to change the
item's order in the list
Up/Down Arrow Select the item to move
Tab to Up/Down Arrow
Image

Move item up or down

Space Bar Activate to move item up or down

Accessibility for Sidebar Icon List
The following keyboard shortcuts are supported for the sidebar icon list for the File menu
Preferences and Properties options.

Table 3-169    Sidebar Icon List — Accessibility Keys

Keys Action

Tab/Shift+Tab Navigate up/down the items in the list.
Space bar Select the item in the list that has focus.

Foundation Services
Related Topics

• Calculation Manager

• Shared Services

• EPM System Installer and EPM System Configurator

Calculation Manager
Related Topics

• Using Accessibility with Calculation Manager

• Navigating in the Script Editor

• Keyboard Equivalents

Using Accessibility with Calculation Manager
Following is a list of suggestions for using accessibility with Oracle Hyperion Calculation
Manager:

• In Oracle Hyperion Enterprise Performance Management Workspace, use these methods
to enter (place cursor focus into) the Calculation Manager iFrame main content area:

– Press Alt+Q to move focus to the System View tab
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– Use the Tab key; or alternately, use keystroke Ctrl+Y, and then press Ctrl+F6 followed
by Tab

– Press Alt+W to move focus to the Select View button menu

• In System View, to place focus in the View menu, move focus to the Select View button
menu, and then press the Right Arrow key.

• To open the button menus, place focus on the button, then use the Down/Up Arrow keys to
move to the selection, and then press Enter to make the selection.

• To select the toolbar icons, use the Tab key to move focus to the New Object icon, and
then use the Right/Left Arrow keys to move focus to the desired toolbar icon. With focus
placed, press Enter to make the selection.

• Use the Tab key to move focus to the Name column header of the tree node; then:

– Use Down/Up Arrow keys to move focus

– Use Ctrl+Right/Left Arrow keys to expand/collapse tree nodes

• To display the context menu for selections in the tree, use Ctrl+Alt+M.

• To select or deselect multiple items, press Shift+Ctrl+Down Arrow/Up Arrow

• To navigate in look ups, press Alt+Shift+H when the lookup loads. Then press the Tab key
to move the focus to the tree table column header, and press the Down Arrow key to select
the first row/member.

• In the New Object definition panel, when using the keyboard to select the Object Type, first
press the spacebar to open the drop down list, and then use the down/up arrow keys to
move focus to the desired type followed by the Enter key to make the selection.

Navigating in the Script Editor
To exit the Script Editor and forward navigate, press [ESC], and then press [Tab].

To exit the Script Editor and reverse navigate to move among the tabs at the top of the editor,
place the cursor in the left-most position of the first line, and then press [Shift] + [Tab].

Keyboard Equivalents
Related Topics

• Context Menu Keys

• Custom View Keys

• Rule Designer Keys

• Ruleset Designer Keys

• Script Debugger Keys

• Script Designer Keys

Context Menu Keys
To invoke the context menu on nodes, press Ctrl+Alt+M.

Custom View Keys
From the Existing Objects palette, you can select objects and press CTRL+SHIFT+C to copy
the objects. Then you can select the location into which you want to copy the objects in the
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main content area, and press CTRL+SHIFT+P to copy the selected objects into the selected
folder.

In the main content area of the Custom view, you can press CTRL+SHIFT+X to select objects
in a folder. Then select another folder and press CTRL+SHIFT+P to move the selected objects
from the first folder to the second folder.

Rule Designer Keys

Table 3-170    Rule Designer Keys

Task Accelerator Key

Within the Rule Designer
New object Ctrl+Shift+N

Save Ctrl+S

Save as Ctrl+Shift+S

Export Ctrl+Shift+X

Print Ctrl+Shift+P

Member Range and Data Range grids
Invoke Comment dialog for the selected dimension Alt+Shift+M

Reset grid Alt+G

Copy from palette and paste into the business rule flow chart
Drag from Existing and New objects palette Ctrl+C

Focus on the flow chart Ctrl+M

Drop or paste by copy T

Paste by reference R

Paste in Else part of a condition component W

Copy and paste within a business rule flow chart
Move all of the selected nodes' focus to the top of each
selected node's column. (The selection is not preserved.)

A

Move all of the selected nodes' focus to the bottom of each
selected node's column. (The selection is not preserved.)

Shift+A

Go to any of the following items:

1. condition, if it’s a node after End-if

2. member block, if it’s an end-member block node

3. member range, if it’s an end-member range node

4. data range if it’s an end-data range node

B

Copy C

Deselect all nodes that are part of the group selection, but
keep the focus and highlight the last node.

D

Go to any of the following items:

1. node after end-if node, if it’s a condition node

2. end-member block, if it’s a member block

3. end-member range, if it’s a member range

4. data range, if it’s an end-data range node

E

Put focus on the begin node F

Add selected node to the group selection G
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Table 3-170    (Cont.) Rule Designer Keys

Task Accelerator Key

Invoke hot key list dialog H

Copy existing component in the designer and drop it into the
Else part of the condition

I

Put focus on the end node L

Go to the Else-condition node only if it’s a condition node N

Move the last selected node's focus to the top of its column
and preserve the selection

P

Move only the last node's focus to the top of its column O

Drop or paste by copy T

Remove a node from the group selection U

Paste V

Copy from the palette and drop into the Else part of the
condition

W

Moves component within the business rule flow chart X

Go to next If condition or move out of condition Y

Undo Z

Zoom out 1

Zoom in 2

Script component/editor
Toggle line number display Ctrl+L

Member selector Ctrl+B

Member selector with range Ctrl+J

Function selector Ctrl+U

Variable selector Ctrl+G

Smartlist selector Ctrl+M

Edit template Ctrl+H

Design time prompt selector Ctrl+E

Trigger auto suggest Ctrl+Space

Trigger auto complete Shift+Space

Comment Ctrl+/

Uncomment Ctrl+Alt+/

Copy Ctrl+C

Paste Ctrl+V

Cut Ctrl+X

Undo Ctrl+Z

Format Ctrl+Alt+O

Verify syntax Ctrl+Alt+S

Hide comments Ctrl+Q

Display comments Ctrl+W

Toggle wrap line Ctrl+Alt+T

Toggle code complete Ctrl+Alt+D

Focus on Go to Line text box Ctrl+I

Focus on Find text box Ctrl+Alt+F

Replace dialog Ctrl+Alt+R

Find next Ctrl+Alt+N
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Table 3-170    (Cont.) Rule Designer Keys

Task Accelerator Key

Find previous Ctrl+Alt+P

Ruleset Designer Keys

Table 3-171    Ruleset Designer Keys

Task Access Key Accelerator Key

Existing objects context menu
Refresh R Ctrl+H

Ruleset tree toolbar
Save S Ctrl+S

Validate and save I Ctrl+Shift+I

Validate V Ctrl+Shift+A

Deploy D Ctrl+Shift+D

Validate and deploy Y Ctrl+Shift+Y

Save As A Ctrl+Shift+S

Export X Ctrl+Shift+X

Print P Ctrl+Shift+P

Ruleset tree toolbar icons
Remove R None available

Move up U Crtl+Shift+U

Move down W Ctrl+Shift+D

Ruleset tree drag and drop
Drag from Existing and New
Objects palette

None available Ctrl+C

Paste into flow chart None available Ctrl+V

Script Debugger Keys

Table 3-172    Script Debugger Keys

Task Access Key Accelerator Key

Action, Edit Ctrl+Shift+U None available

Script Debugger
Navigate to script section Alt+S None available

Navigate to properties (current
members and break point )
section

Alt+P None available

Navigate to current values section Alt+U None available

Start/resume Debug Ctrl+Shift+R None available

Cancel Debug Ctrl+Shift+N None available

Insert Break Point Ctrl+B None available

Remove Break Point Ctrl+B None available

Insert Condition Ctrl+Shift+O None available
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Table 3-172    (Cont.) Script Debugger Keys

Task Access Key Accelerator Key

Remove Condition Ctrl+O None available

Edit Condition Ctrl+Q None available

Context Menu
Start Debug None available T

Add Break Point None available B

Remove Break Point None available P

Add Condition None available A

Edit Condition None available E

Remove Condition None available R

Script Designer Keys

Table 3-173    Script Designer Keys

Task Accelerator Key

Script Designer
Action Menu, Save Ctrl+S

Action Menu, Save As Ctrl+Shift+S

Action Menu, Validate Ctrl+Shift+V

Action Menu, Validate and Save Ctrl+Shift+I

Action Menu, Export Ctrl+Shift+P

Script Component/Editor
Toggle line number display Ctrl+L

Member selector Ctrl+B

Member selector with range Ctrl+J

Function selector Ctrl+U

Variable selector Ctrl+G

Smartlist selector Ctrl+M

Edit template Ctrl+H

Design time prompt selector Ctrl+E

Trigger auto suggest Ctrl+Space

Trigger auto complete Shift+Space

Comment Ctrl+/

Uncomment Ctrl+Alt+/

Copy Ctrl+C

Paste Ctrl+V

Cut Ctrl+X

Undo Ctrl+Z

Format Ctrl+Alt+O

Verify syntax Ctrl+Alt+S

Hide comments Ctrl+Q

Display comments Ctrl+W

Toggle wrap line Ctrl+Alt+T

Toggle code complete Ctrl+Alt+D
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Table 3-173    (Cont.) Script Designer Keys

Task Accelerator Key

Move the focus to the Go to Line text box Ctrl+I

Move the focus to the Find text box Ctrl+Alt+F

Replace dialog Ctrl+Alt+R

Find next Ctrl+Alt+N

Find previous Ctrl+Alt+P

Shared Services
Related Topics

• Shared Services Console Accessibility Features

• Shared Services Console Keyboard Equivalents

Shared Services Console Accessibility Features
• Screens used to create and modify the following artifacts do not support high contrast

mode.

– Users

– Groups

– Roles

– Delegated Lists

• JAWS Screen Reading Software reads only the title and first paragraph of each help topic.
All text that comes after the first paragraph is skipped.

Shared Services Console Keyboard Equivalents
Related Topics

• Overview

• Global Keyboard Equivalents

• Menus

• Administration Tasks

• Provisioning Tasks

• Application Management Tasks

Overview
This section describes the keyboard equivalents for the following:

• Interface components

• Menu items

• Tasks completed in Shared Services Console

When you use keyboard equivalents, keep in mind the following:
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• The underlined letter that typically appears in a menu title, menu item, or the text of a
button or other component is called a mnemonic. Because Oracle considers mnemonics to
be "self-documenting", no additional documentation of these keys is provided. However, it
is important to note that some mnemonics are repeated. For example, on the File menu,
the underlined mnemonic D is used for both the Delete menu item and the Deactivate
menu item. When this occurs, the first time you press D, highlights the item to be deleted.
Press Enter to Delete or press D again to highlight the Deactivate button, and then press
Enter to Deactivate.

• If you are using a version of the Firefox browser later than release 1.5, substitute Alt+Shift
for Alt as the modifier.

Global Keyboard Equivalents
Use these global keyboard equivalents to navigate Oracle Hyperion Shared Services Console.

Table 3-174    Global Keyboard Equivalents

Keys Action

F10 Focus and activate the first menu on the menu bar.
Ctrl+0 Focus on the first object listed in the View pane.
Ctrl+G Focus on the task tabs. Focus shifts to the current task tab.
Ctrl+T Focus on the toolbar. Focus shifts to the toolbar itself, and then you

can use Tab to select individual buttons.
Ctrl+Y Focus on the current task tab in the content area.
Ctrl+F4 Close the current tab (except the Browse tab).
Space bar Activate the selected object in the View pane.
F9 Display the shortcut menu for the selected object in the View pane.
Ctrl+F6 Focus away from a task tab to the page frame.

Menus
Use these keyboard equivalents when Oracle Hyperion Shared Services Console is displayed.

Note:

Keyboard equivalents for menus are context sensitive. In other words, different menu
options are available for each type of task.

Table 3-175    Keyboard Equivalents for File Menu

Keys Action

Ctrl+N New
Ctrl+O Open
Ctrl+Shift+R Properties
Ctrl+D or DEL Delete an object
Ctrl+E Activate
Ctrl+D Deactivate
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Table 3-176    Keyboard Equivalents for View Menu

Keys Action

Ctrl+Alt+0 View Masthead
Ctrl+F Refresh Shared Services Console
Ctrl+X Explore

Table 3-177    Keyboard Equivalents for Administration Menu

Keys Action

Ctrl+Shift+T View Provisioning Report
Ctrl+Shift+B Security Reports/Performed By
Ctrl+Shift+O Security Reports/Performed On
Ctrl+Shift+V Provision
Ctrl+Shift+D Deprovision
Ctrl+L Delete Applications
Ctrl+U Audit Report
Ctrl+P Config Report
Ctrl+R Configure Auditing

Note:

To access the Security Reports, Artifact Reports, and Config Reports sub menu items
under Audit Reports, use the down arrow key to highlight Audit Reports, and then
press the right arrow key to display the sub-menu items. Press S (for Security
Reports), F (for Artifact Reports), or P (for Config Reports) to launch the
corresponding reports.

Administration Tasks
Use these keyboard equivalents when performing administration tasks.

Table 3-178    Migration Options Tab

Keys Action

Alt+L Close
Alt+V Save

Table 3-179    Configure User Directories: Provider Configuration Tab

Keys Action

Alt+W New
Alt+D Edit
Alt+E Delete
Alt+P Move Up
Alt+M Move Down
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Table 3-179    (Cont.) Configure User Directories: Provider Configuration Tab

Keys Action

Alt+U Include
Alt+X Exclude
Alt+T Test

Table 3-180    Audit Configuration Window

Keys Action

Alt+P Purge

Table 3-181    Audit Reports

Keys Action

Alt+E View Report
Alt+X Export

Table 3-182    Select User or Group Screen

Keys Action

Alt+E Select All
Alt+T Select
Alt+L Close
Alt+R Search

Provisioning Tasks
Use these keyboard equivalents when provisioning users, groups, tasks, or delegated lists.

Table 3-183    Provisioning Users

Keys Action

Ctrl+N New
Ctrl+Shift+R Properties
Delete Delete
Ctrl+E, Enter Activate
Ctrl+D, Enter Deactivate
Ctrl+Shift+T View Provisioning Report
Ctrl+Shift+B Security Reports/Performed By
Ctrl+Shift+O Security Reports/Performed On
Ctrl+Shift+V Provision
Ctrl+Shift+D Deprovision
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Table 3-184    Provisioning Groups

Keys Action

Ctrl+N New
Ctrl+Shift+R Properties
DEL Delete
Ctrl+Shift+O Security Reports/Performed On
Ctrl+Shift+V Provision
Ctrl+Shift+D Deprovision

Table 3-185    Provisioning Roles

Keys Action

Ctrl+N New
Ctrl+Shift+R Properties
DEL Delete
Ctrl+Shift+T View Provisioning Report

Table 3-186    Provisioning Delegated Lists

Keys Action

Ctrl+N New
Ctrl+Shift+R Properties
DEL Delete
Ctrl+Shift+T View Delegated Report

Application Management Tasks
Use these keyboard equivalents when working with application groups.

Table 3-187    Application Management Tasks

Keys Action

Ctrl+N Create New Application
Ctrl+D Delete Application
Ctrl+O Open
Ctrl+D Delete
Ctrl+U Audit Report
Ctrl+P Configure Report
Ctrl+R Configure Auditing
Ctrl+M Move To
Ctrl+I Copy Provisioning
Ctrl+X Explore
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Table 3-188    Artifact List Tab

Keys Action

Alt+T Artifact List button
Alt+E Selected Artifacts button
Alt+S Search Artifacts button
Alt+C Select All/Clear Selections button
Alt+U View Audit Report button
Alt+R Export button
Alt+L Close

Table 3-189    New/Modify Application Group Screen

Keys Action

Alt+I Finish
Alt+L Close
Alt+U Update List

Table 3-190    Export Dialog Box

Keys Action

Alt+E Export
Alt+L Close

Table 3-191    Import Dialog Box

Keys Action

Alt+I Import
Alt+L Close

Table 3-192    Move To Tab

Keys Action

Alt+R Search
Alt+Y Display All

Table 3-193    Copy Provisioning Tab

Keys Action

Alt+R Search
Alt+Y Display All
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Table 3-194    Purge Migration Status Report

Keys Action

Alt+I Finish

Table 3-195    Purge Screen

Keys Action

Alt+E Purge

Table 3-196    Migration Status Report

Keys Action

Alt+R Refresh

EPM System Installer and EPM System Configurator
Enabling Accessibility

You must launch EPM System Installer and EPM System Configurator in GUI mode to use
their accessible versions.

To use an accessible version of EPM System Installer:

1. Launch EPM System Installer in GUI mode:

a. (Windows) From a Windows console, change to the root directory to which you
extracted the EPM System Installer files and type installTool.cmd -gui.

b. (UNIX) Change to the root directory to which you extracted the EPM System Installer
files and enter ./installTool.sh -gui.

Tip:

If you are using JAWS screen reader software and want to interrupt reading
of large text blocks (for example, the list of assemblies or Welcome text in
Oracle Hyperion Enterprise Performance Management System Installer),
press Ctrl. To re-read a prompt line, press Insert + Up Arrow or Down
Arrow. To re-read an entire dialog box, press Ctrl + 5.

2. You can press Enter to accept the default selection and move to the next page.

To use an accessible version of EPM System Configurator:

1. Launch EPM System Configurator in GUI mode:

a. (Windows) From a Windows console, change to EPM_ORACLE_HOME/common/config/
version_number, and then enter configtool.bat -gui.

b. (UNIX) Change to EPM_ORACLE_HOME/common/config/version_number and then
enter ./configtool.sh —gui.

2. You can press Enter to accept the default selection and move to the next page.
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Planning
Related Topics

• Accessibility Features
Defines accessibility features for Oracle Hyperion Planning accessibility.

• Using Screen Reader Mode
Defines using screen reader mode for Oracle Hyperion Planning accessibility.

• Using Keyboard Equivalents
Defines using keyboard equivalents for Oracle Hyperion Planning accessibility.

Accessibility Features
Defines accessibility features for Oracle Hyperion Planning accessibility.

These features are provided:

• Alt+Z to skip navigation links and move focus to the main content area

• Support for screen readers and magnifiers

• Keyboard navigation equivalents for all objects

• Alt and Title attributes for all objects, images, and page titles

• Support for expanding and collapsing trees using the Alt + right/left arrow keys

• Data form access using keyboard equivalents

• Tab indexing, implemented from left to right on all pages

Using Screen Reader Mode
Defines using screen reader mode for Oracle Hyperion Planning accessibility.

• In rule launch windows, select the corresponding buttons to invoke the member selector for
runtime prompts.

• If, after you perform validations, cells contain errors, you must tab through each cell to
locate those with errors. Clicking error messages in the Data Validation Summary does not
place focus on the corresponding cell with errors.

• If you launch a secondary dialog box such as the member selector while in screen reader
mode, press Alt+Z to switch focus from the main dialog box to the secondary dialog box.
You can then tab to navigate the dialog box.

• For information icons, click icons for additional information.

• Graphs and charts do not display; everything is rendered in table format. Use Ctrl+ and
Alt+ arrow keys to read the content of such tables.

• Turn the PC Cursor Mode to ON when tabbing through read-only fields in a table. Turn the
PC Cursor Mode to OFF when entering data in editable fields.

• To read the content of a text area, select all text inside the text area by pressing Ctrl+A.

• When the screen reader is on, to close any open dialog boxes, press Escape twice.

• When a popup such as a confirmation message appears on save or rule launch, use the
Down Arrow keys to read the message after the screen reader announces the popup. Use
the same process for informational popups.
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• In Microsoft Edge, you can press Tab + N to read a confirmation message in the screen
reader.

Using Keyboard Equivalents
Defines using keyboard equivalents for Oracle Hyperion Planning accessibility.

When you use keyboard equivalents, note that:

• The underlined letter that typically appears in a menu title, menu item, or button text is
called a mnemonic. Because Oracle considers mnemonics to be "self-documenting,"
additional documentation for mnemonics is not necessarily provided. You can use
mnemonics where they are implemented.

• Where the mnemonics are repeated using the same defined character, repeating the
character selection will move focus through the menu items.

• Keystrokes listed are standard for PCs. iOS standard keys may be different.

• If you use Firefox, use Alt+Shift for Alt as the modifier.

Some options and movements do not need an assigned keyboard shortcut. In these cases,
use the Tab key for navigation.

Access Keys for Left Pane Accordion Controls
Defines access keys for left pane accordion controls for Oracle Hyperion Planning accessibility.

Setting up Correct Navigation from Open Artifacts to Accordion Controls

An Administrator must add a new property named TASKLIST_FOCUS_AT_BEGINNING to the
application to ensure correct navigation from open artifacts (such as forms and tasks) to the
left accordion area for a new artifact selection.

To configure TASKLIST_FOCUS_AT_BEGINNING property:

1. Sign into Planning as a System Administrator.

2. From Navigate, select Applications , then Planning, and then select your Planning
application.

3. In the Planning application, from Administration, select Application and then Properties.

4. In Application Properties on the Manage Properties pane, click the Add icon to create a
new row.

5. In the new row, enter this information:

• Property Name: TASKLIST_FOCUS_AT_BEGINNING

• Property Value: true

6. Click Save.

Table 3-197    General Access Keys

Keys Action

Alt+M+Enter Open the Forms accordion.

Alt+L+Enter Open the My Task Lists accordion.

Alt+L+Enter Open the Task Lists accordion.

Alt+S+Enter Open the Dimension accordion.
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Table 3-197    (Cont.) General Access Keys

Keys Action

Alt+B+Enter Open the Business Rule Security accordion.

Alt+R+Enter Open the Preferences accordion.

Table 3-198     Left Pane Navigation

Keys Action

Alt+M Focus on the Forms Accordion

Alt+L Focus on the Task List Accordion or My Task List
Accordion. For planners, Alt+L focuses on My Task
List Accordion.
For administrators and Interactive users:

1. First, focus moves to Task Lists Management.

2. Pressing Alt+L again moves focus to My Task
List accordion.

Alt+S Focus on the Dimension Editor accordion

Alt+B Focus on the Business Rules Security accordion

Alt+R Focus on the Preferences accordion

Alt+Z+Tab Move focus to the first available field on the right
content pane.

Alt+O Focus on the Form Folder sub accordion

Alt+M Focus on the Forms sub accordion

Alt+U Focus on the Business Rules sub accordion

Note: After the focus moves to the accordion,
pressing Enter toggles between expand and
collapse actions.

These keyboard shortcuts are for page level
actions for the Planning artifact management
pages such as Form Management, Task List
Management, Dimension Editor, and Menu
Management.

Accelerator Keys
Defines accelerator keys for Oracle Hyperion Planning accessibility.

Table 3-199    Manage Artifacts - Page-Level Actions

Keys Action

Ctrl+W Create, add, or add child

Ctrl+E Edit

Crtl+Shift+R Rename

Ctrl+M Move

Ctrl+Shift+G Assign access

Crtl+Shift+B Add sibling

Ctrl+B Show ancestors

Ctrl+U Show usage

Ctrl+Shift+U Move up

Ctrl+Shift+D Move down
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Table 3-199    (Cont.) Manage Artifacts - Page-Level Actions

Keys Action

Ctrl+H Refresh, Sync

Ctrl+F Search default action

Ctrl+Shift+F Focus on the Search input box

Ctrl+S Save

Ctrl+Shift+L Cancel operation

Ctrl+M Add to selected list

Ctrl+Shift+W Add all to selected list

Ctrl+R Remove from selected list

Ctrl+Shift+R Remove all from selected list

Ctrl+Up Arrow Move up selected in the selected list

Ctrl+Down Arrow Move down selected in the selected list

Ctrl+S Save artifact

Ctrl+Shift+S Save as artifact

Ctrl+Shift+P Previous tab

Ctrl+Shift+N Next tab

Esc Cancel

Ctrl+Shift+F Finish

Ctrl+W
Note: These keys are used for page-level actions
for artifact management pages such as form
Management, Task List Management, Dimension
Editor, and Menu Management.

Preview

Table 3-200    Simple Form, Composite Form, and Grid Management

Access Keys Keyboard Equivalent Action

Focus on Properties tab Alt+P Focus on the Properties tab

Focus on Layout tab Alt+Y Focus on the Layout tab

Layout Tab Alt+G Focus on the Grid Properties Section

Focus on Section Properties panel Alt+M Focus on the Dimensions Properties
panel

Focus on Section Properties panel Alt+S Focus on the Section Properties panel

Focus on Smart View Option panel Alt+S Focus on the Smart View Option Panel

Segment View Alt+S Segment View

Focus on Display Properties Panel Alt+I Focus on the Display Properties Panel

Focus on Printing Options Properties
panel

Alt+P,P Focus on the Printing Options
Properties Panel

Focus on Validation Rules Properties
panel

Alt+ V,V Focus on the Validation Rules
properties Panel

Drop selected dimension to POV section Ctrl+Shift+V Drop selected dimension to POV section

Drop selected dimension to Page
section

Ctrl+Shift+P Drop selected dimension to Page
section

Drop selected dimension to Rows
section

Ctrl+Shift+R Drop selected dimension to Rows
section

Drop selected dimension to Columns
section

Ctrl+Shift+C Drop selected dimension to Columns
section
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Table 3-200    (Cont.) Simple Form, Composite Form, and Grid Management

Access Keys Keyboard Equivalent Action

Dimension context menu Enter Tab through row/column header and
press Enter to bring up the Context
Menu.
Tab through to the Dimension and press
Enter to bring up the dimension context
menu.

Validation Rules: Access Keys on
Validation Panel For Validation Rules

Alt+P Focus on Page Section

Member Selector on Point of View
section

Alt+P,V+Enter Invoke Member Selector on Point Of
View section

Member Selector on Page section Alt P,P+Enter Invoke Member Selector on Page
section

Other Options tab Alt+O Focus on the Other Options tab

Other Options tab : Access Keys

Precision Panel Alt+R Focus on the Precision Panel

Business Rules tab Alt+R

Business Rules : Access Keys

Business Rules tab Alt+R Focus on the Business Rules tab

Plan type drop-down list Alt+P Focus on the Plan type drop-down list

Table 3-201    Form and Grid Management Keyboard Shortcuts

Access Keys Keyboard Equivalent Action

Composite Forms Access keys Access keys Show Menu for layout sections

Composite Forms Access keys Alt+Y Select Layout Panel

Composite Forms Access keys Alt+O Toggle selection between Custom
Layout/2 Row Layout/2 Column
Layout

Composite Forms Access keys Alt+S Select Section properties Panel

Composite Forms Access keys Alt+G Toggle focus and selection
between Global Layout
Dimension/Common Dimension
properties Panel

Keyboard Shortcuts Crtl+Shift+A Display forms as Tabs

Keyboard Shortcuts Ctrl+Shift+N Add form

Keyboard Shortcuts Ctrl+Delete Delete selected form

Keyboard Shortcuts Ctrl+Shift+E Edit Form Label

Keyboard Shortcuts Ctrl+Shift+T Move to Top

Keyboard Shortcuts Ctrl+Shift+B Move to Bottom

Keyboard Shortcuts Ctrl+Shift+U Move Up

Keyboard Shortcuts Ctrl+Shift+D Move Down
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Table 3-202    Enter Data

Keyboard Equivalent Action

Ctrl+Shift+T Focus is moved onto the next form. If the form is
within a tabbed pane, the tab is disclosed.

Note:

If you are working in
edit mode within a
composite form, you
must first press Esc.

Alt+ . Go to the page dimension.

Table 3-203    Menu Management

Access Keys Keyboard Equivalent Action

Add, Edit Menu, Menu Item Alt+N Toggle focus on Menu Name or
Menu Item Name input boxes.

Select Form Folder or Form
button

Alt+S Toggle focus on Select Form
Folder or Form button.

Table 3-204    Smart Lists

Access Keys Keyboard Equivalent Action

Create, Edit Smart List Alt+P Focus on the Properties tab.

Entries tab Alt+R Focus on the Entries tab.

Save Smart List edit Alt+S Save the Smart List edit.

Cancel Smart List edit Alt+L Cancel the Smart List edit.

Focus on Preview tab Alt+W Focus on the Preview tab.

Table 3-205    Task Lists

Keyboard Equivalent Action

Alt+K Focus on the Task List tab.

Alt+C Toggle focus between Task List Name and the
Clear drop-down list.

Alt+K Focus on the Task Name in the task Detail panel.

Alt+I Focus on the Instructions tab.

See "Rich Text Editor" section for Access and
Control Keys for Rich Text Editor

Table 3-206    User Variables

Keyboard Equivalent Action

Alt+U Focus on the User Variables tab
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Table 3-206    (Cont.) User Variables

Keyboard Equivalent Action

Alt+S Focus on the Substitution Variables tab

Alt+A Focus on the Attribute Variables tab

Table 3-207    Business Rules Security

Keyboard Equivalent Action

Alt+M Move the rule

Alt+G Assign Access to rule

Table 3-208    Clear Cell Details

Access Keys Keyboard Equivalent Action

Keyboard Shortcuts Alt+P Focus on the Plan Type drop-down list

Keyboard Shortcuts Alt+M Toggle focus between Member Selector
in static dimension Rows

Keyboard Shortcuts Alt+A Toggle focus between Add All
Dimensions button and Add Static
Dimension icon in Static Dimension
Panel

Keyboard Shortcuts Alt+C Selects, Invokes Clear Action

Table 3-209    Copy Data

Keyboard Equivalent Action

Alt+P Focus on the Plan Type drop-down list

Alt+M Toggle between the Member Selector in static
dimension rows

Alt+A Toggle between Static Dimension, Dimension with
Source, and Destination Panel

Alt+C Selects, Invokes Copy Action

Table 3-210    Dimension Editor

Access Keys Keyboard Equivalent Action

Performance Settings Alt+P Focus on the Performance Settings tab

Evaluation Order Alt+O Focus on the Evaluation Order tab

Dimensions tab Alt+R Focus on the Sort options drop-down list

Sort Up Alt+R+Tab Focus on the Sort Up icon command
button

Sort Down Alt+R+Tab+Tab Focus on the Sort Down icon Command
button

Search list Alt+S Focus on the Search drop-down options
list

Search input Alt+S+Tab Focus on the Search input box

Add Dimension Alt+W Focus on Add Dimension
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Table 3-210    (Cont.) Dimension Editor

Access Keys Keyboard Equivalent Action

Edit Dimension Alt+G Focus on Edit Dimension

View Dimension Alt+G Focus on View Dimension

Add Child/Sibling Alt+P Focus on the Member Properties tab

UDA tab Alt+U Focus on the UDA tab

Member Formula Alt+M Focus on the Member Formula tab

Member Properties Tab Alt+N Focus on the Name input box

Description input Alt+D Focus on the Description input box

Toggle Alias Table, Smart List Alt+S Toggle focus between:
• The Alias Table drop-down list and

the Alias input box
• The Smart List drop down list and

Data Storage/Data Type

Account Alt+Y Toggle focus on Account drop-down list

Variance Reporting Alt+R Focus on the Variance Reporting drop
down list

Time Balance Alt+B Focus on the Time Balance drop-down
list

Source Plan Type Alt+P Toggle focus between the Source Plan
Type drop down and Plan Type

Hierarchy Type Alt+H Focus on the Hierarchy Type box

Member Formula tab Alt+V Execute Validate

Access Keys Alt+P Focus on the Plan Type drop-down list

Access Keys Alt+P Focus on the Plan Type drop-down list

Custom Attributes Ctrl+0 (zero) Add Custom Attributes

Show Ancestors Ctrl+B Show Ancestors

Options Alt+P Options

Dynamic Time Series Ctrl+J Dynamic Time Series

Summary Time Period Alt+L Add Summary Time Period

Copy Scenario Ctrl+Q Copy Scenario

Keyboard Shortcuts Alt+P Plan type

Table 3-211    Member Formula Script Editor

Script Component Access Keys

Find Ctrl+Alt+ F

Replace Ctrl++Alt+R

Member Selector Alt+Shift+

Function Selector Alt+ Shift+

Variable Selector Alt+Shift+G

Smart List Selector Alt+Shift+M

Trigger auto suggest Ctrl+Space

Comment Ctrl+/

Copy Ctrl+C

Paste Ctrl+V

Cut Ctrl+X
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Table 3-211    (Cont.) Member Formula Script Editor

Script Component Access Keys

Undo Ctrl+

Format Alt+Shift+O

Verify Syntax Alt +Shift+S

Perform next search for text string instance in the
editor (when the Find dialog box is open)

Alt+F

Table 3-212    Assign Access Pop-Up

Access Keys Keyboard Equivalent Action

Users tab Alt+U Focus on the Users tab

Group tab Alt+G Focus on the Group tab

Remove Non Provisioned Users
or Groups

Alt+R Focus on the Remove Non
Provisioned Users or Groups
button

Add or Edit Access Pop-up
Access Keys

Alt+G Toggle focus between the Read,
Write, and None boxes

Table 3-213    User Selector (Select and Assign Owner)

Keyboard Equivalent Action

Alt+U Select the Users tab

Alt+G Select the Groups tab

Table 3-214    Currency Conversion

Access Keys Keyboard Equivalent Action

Currency Conversion Alt+M Toggle between version types

All other actions All other access and actions are
completed with tab key traversal

Exchange Rate Management Alt+C Set Focus on the Create Rate
Table icon

Edit Rate Table Alt+I Set Focus on the Edit Rate Table
icon

Delete Rate Table Alt+9 Set Focus on the Delete Rate
Table icon

Table 3-215    Broadcast Message

Access Keys Keyboard Equivalent Action

Broadcast Message Alt+S Select or invoke the Send button
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Table 3-216    Reports

Access Keys Keyboard Equivalent Action

Access Keys Alt+O Select the Forms tab

Planning Unit Annotations Alt+P Select the Planning Unit
Annotations tab

Planning Unit Tab Alt+S Toggle between select Scenario
and version and entity drop down

Planning Unit Tab Alt+M Toggle between Member selector
for scenario, Version Entity

Table 3-217    Create or Refresh Database

Access Keys Keyboard Equivalent

Create or Refresh Database Tab traversal only

Table 3-218    Outline Load

Access Keys Keyboard Equivalent Action

Scroll Ctrl+Shift+Left Arrow or Right
Arrow

Scroll left or right

Access Keys Alt+R Run Outline Load

Reset Outline Load Alt+S Reset Outline Load inputs

Table 3-219    Data Load Administration

Access Keys Keyboard Equivalent Action

Access Keys Alt+L Toggle focus between the Data
Load Dimension and the Driver
Dimension drop-down lists

Member Selector Alt+M Select Member Selector

Advanced Setting panel Alt+A Add Row

Duplicate Row Alt+U Duplicate Row

Delete Row Alt+R Delete selected row

Table 3-220    Map Reporting Application

Access Keys Keyboard Equivalent Action

Select Application Alt+A Select Application tab

Select Map Alt+M Select Map dimensions tab

Select point of view Alt+P Select point of view tab

Application Tab

Access Keys Alt+N Focus on the Application Name
input box

Plan type Alt+P Focus on the Plan type drop
down in Source application panel

Map Dimensions Tab or Point Of
View Tab

Focus Select Member selector
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Table 3-220    (Cont.) Map Reporting Application

Access Keys Keyboard Equivalent Action

Access Keys Alt+M

Table 3-221    Planning Unit Hierarchy

Access Keys Keyboard Equivalent Action

Access Keys Alt+O Selects Approvals Dimension Entity tab

Primary and SubHierarchy selection Alt+P Selects Primary and SubHierarchy
selection tab

Assign Owners Alt+G Select Assign Owners tab

Usage Alt+U Selects Usage tab

Approvals Dimension Entity tab

Access Keys Alt+N Focus on the Hierarchy Name input box

Primary and SubHierarchy selection,
Assign Owners tab

Access Keys Alt+Y Focus on Display button

Reset to DefaultHierarchy Alt+R Selects "Reset to DefaultHierarchy"
button

Parent Member Alt+M Toggle focus on Parent Member input
field in Parent Member column and
Selected Member input box in Selected
Members column

Member selector Alt+M Toggle focus on Member selector in
"Parent Member" and "Selected
Members" column

Relative generation Alt+J Focus on the Relative generation input
box

Auto Include Alt+K Focus on the Auto Include checkbox in
"Auto Include" Column

Assign Owner Alt+W Toggle focus on Assign Owner input box
and Assign owner selector command
icon button

Reviewer Alt+R Toggle focus on Reviewer input box and
Assign owner selector command icon
button

Promotion path Alt+H Selects Promotion path icon command
button

Notify These Users Alt+Y Toggle focus on "Notify These Users"
input box and user selector command
icon button

Search Alt+S Toggle focus on search drop-down list/
Search input box

Table 3-222    Plan Type Editor

Access Keys Keyboard Equivalent Action

Keyboard Shortcuts Ctrl+S Save plan type

Add plan type Ctrl+W Add plan type

Delete plan type Ctrl+Delete Delete plan type
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Table 3-223    Scenario Version Assignment

Access Keys Keyboard Equivalent Action

Actions Alt+A Focus on the Actions icon in the
table

File Based Export Import Tab key traversal only

Manage Approvals

Access Keys Alt+R Toggle focus between the
Scenario, and Version drop-down
lists

Search drop-down list Alt+S Focus on the Search drop-down
list

Search box Alt+S+Tab Focus on Search box

Out of Office Assistant Alt+O Focus on the Out of Office
Assistant link

Exclude button Alt+X Focus on the Exclude button on
Plan Cycle column

Start button Alt+T Focus on the Start button on Plan
Cycle column

Promotional path Alt+P Focus on the Promotional path
icon command button

Table 3-224    Copy Version

Access Keys Keyboard Equivalent Action

Access Keys Alt+S Select Scenario drop-down list

Toggle focus from Copy From to
Copy To

Alt+C Toggle focus between Copy From
to Copy To drop-down list

Go Alt+G Select Go Button

Toggle focus from available to
selected entities

Alt+M Toggle focus between Available
entities and selected Entities

Copy Data Alt+P Selects Copy Data button

Table 3-225    Business Rules

Access Keys Keyboard Equivalent Action

Business Rules Alt+P Toggle focus between Plan type
and Rule type drop-down list

Display only launchable rules,
rulesets, and calc script

Alt+Y Focus on the "Display only
launchable rules, rulesets, and
calc script" checkbox

Table 3-226    Job Console

Access Keys Keyboard Equivalent Action

Job Status Alt+S Toggle focus between Start Time
and End Time input boxes

Toggle Start Time and End Time Alt+S+Tab Toggle focus between Start Time
and End Time input date time
selector
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Table 3-226    (Cont.) Job Console

Access Keys Keyboard Equivalent Action

Job type Alt+J Focus on the Job type drop-down
list

Status Alt+U focus on Status drop-down list

Toggle Job Name, Username Alt+N Toggle focus on Job Name,
Username input Box

Go Alt+G Selects Go button

Table 3-227    Diagnostics (Grid)

Keyboard Equivalent Action

Alt+V Toggle focus between Available forms and Selected
form

Alt+R Selects "Run Diagnostics" button

Alt+D Toggle focus between Tabular and Chart buttons

Table 3-228    Member Selector

Access Keys Keyboard Equivalent Action

Member Selector Alt+M Focus on the Members tab

Variables tab Alt+R Focus on the Variables tab

Members tab Alt+N Focus on the Search box

Display properties Alt+P Shift Focus to Display properties

Toggle filtered search Alt+F Toggle focus on filtered search
icon

Search Up Alt+U Focus on Search Up

Search Down Alt+S Focus on Search Down

Toggle Keep only functions,
Attributes, and Generations

Alt+K Toggle focus on Keep only
functions, Attributes, and
Generations icon

Keyboard Shortcuts Ctrl+Shift+F Toggle focus on Function
Selector

Variables Tab Alt+V Toggle focus on User Variables
Panel and Substitution Variables
Panel

Table 3-229    Comments - Pop Up

Keyboard Equivalent Action

Alt+C Focus on the Comments Panel

Alt+A Focus in Add button

Alt+E Focus on the Existing Comments Panel

Alt+Y Focus on the "Apply to all selected cells" checkbox
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Table 3-230    Document Attachment

Keyboard Equivalent Action

Alt+X Focus on Delete

Alt+E Focus on the Edit Icon command button

Alt+A Focus on the Add Icon Command button

Alt+Y Focus on the "Apply to all selected cells" checkbox

Table 3-231    Accelerator Keys Reserved for Page-Level Components

Accelerator Key Used In Function

Ctrl+Alt+W Pop-up Toggle focus between open
popups.

Ctrl+Shift+W Messaging, Secondary Windows Toggle focus between open
popups.

Ctrl+Alt+P Splitter Give focus to splitter bar.

Table 3-232    Access Keys For Various Browsers

Browser Operating System Key Combination Action

Mozilla Firefox Linux Alt+Shift+mnemonic Click

Mozilla Firefox Mac OS X Ctrl+mnemonic Click

Mozilla Firefox Windows Alt+Shift+mnemonic Click

Microsoft Edge Windows Alt+mnemonic Click or set focus

Note:

For Google Chrome, to move the cursor focus out of a grid, press Ctrl+Alt+E.

Table 3-233    Shortcut Keys Assigned to Common Components

Shortcut Key Components Action

Enter

Space

All components Activate the component, or the
component element that has the focus.

Tab

Shift+Tab

All components

Flash components like ThematicMap,
Graph, and Gauge

Move focus to next or previous editable
component.

Ctrl+A All components Select all.

Left Arrow

Right Arrow

Menu Bar

Splitter

Input Number Slider

Input Range Slider

Input Number Spinbox

Move focus to different menu on a menu
bar.

Move splitter left or right when it is in
focus.

Move slider left or right when input
number slider or input range slider is in
focus.

Increment or decrement the value when
input number box is in focus.
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Table 3-233    (Cont.) Shortcut Keys Assigned to Common Components

Shortcut Key Components Action

Up Arrow

Down Arrow

Menu

Splitter

Input Number Slider

Input Range Slider

Move focus to different menu items in a
menu.

Move splitter up or down when it is in
focus.

Move slider up or down when input
number slider or input range slider is in
focus.

Table 3-234    Shortcut Keys for Rich Text Editor

Shortcut Key Action

Ctrl+B Boldface

Ctrl+I Italics

Ctrl+U Underline

Ctrl+5 Strikethrough

Ctrl+E Center alignment

Ctrl+J Justify

Ctrl+L Align text left

Ctrl+R Align text right

Ctrl+H Create hyperlink

Ctrl+M Increase indent

Ctrl+Shift+M Decrease indent

Ctrl+Shift+H Remove hyperlink

Ctrl+Shift+S Clear text styles

Ctrl+Alt+- Subscript

Ctrl+Alt++ Superscript

Ctrl+Z Undo

Table 3-235    Shortcut Keys Assigned to Table, Tree, and Tree Table

Shortcut Key Components Action

Tab

Shift+Tab

Table

Tree Table

Move focus to next or previous cell or
editable component.

In a table, navigate to the next or
previous editable content in cells. If the
focus is on the last cell of a row in the
table, the Tab key moves focus to the
first editable cell in the next row.
Similarly, Shift+Tab moves focus to the
previous row.

Ctrl+Alt+M Table

Tree

Tree Table

Launch context menu.
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Table 3-235    (Cont.) Shortcut Keys Assigned to Table, Tree, and Tree Table

Shortcut Key Components Action

Enter

Shift+Enter

Table

Tree

Tree Table

Navigate to the next editable cell or
previous editable cell of the column.

Makes selection of focused node in tree.

If the focus is on the filter cell, perform
table filtering. Makes selection of
focused node in tree.

Left Arrow

Right Arrow

Table

Tree Table

Move focus.

Up Arrow

Down Arrow

Table

Tree Table

Move focus.

If a row is selected, then move focus to
the previous row or next row. If no row is
selected, scroll the table one row up or
down.

If the first row is selected, move focus to
the column header.

Shift+Up Arrow

Shift+Down Arrow

Table

Tree Table

Tree

Select multiple rows of column values.

Space Table On row/column headers, select entire
row/column.

Shift+Space Table Select multiple rows.

Esc Table

Tree Table

Remove selection.

If the focus is on the cell, exit click-to-
edit mode, revert the cell value to
original value, and return focus to the
cell. Press Esc key again to move focus
to the row header.

Table 3-236    Shortcut Keys for My Task List

Shortcut Key Action

Up Arrow Move focus up in My Task List

Down Arrow Move focus down in My Task List

Ctrl+Right Arrow Expand element in My Task List

Ctrl+Left Arrow Close element in My Task List

Menus
Related Topics

• Main Menu
Defines keyboard equivalents to open the menus that are available from the menu bar for
Oracle Hyperion Planning accessibility.

• File Menu
Defines keyboard equivalents used in the File Menu for Oracle Hyperion Planning
accessibility.
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• Edit Menu
Defines keyboard equivalents used in the Edit menu for Oracle Hyperion Planning
accessibility.

• View Menu
These keyboard equivalents are used in the View Menu in basic mode for Oracle Hyperion
Planning accessibility.

• Tools Menu
Defines keyboard equivalents used in the Tools Menu for Oracle Hyperion Planning
accessibility.

• Administration Menu
Defines keyboard equivalents used in the Administration Menu for Oracle Hyperion
Planning accessibility.

• Help Menu
Defines keyboard equivalents used in the Help Menu for Oracle Hyperion Planning
accessibility.

Main Menu
Defines keyboard equivalents to open the menus that are available from the menu bar for
Oracle Hyperion Planning accessibility.

Table 3-237    Keyboard Equivalents for the Main Menu

Keys Action

Alt+F Opens the File menu

Alt+E Opens the Edit menu

Alt+V Opens the View menu

Alt+A Opens the Administration menu

Alt+T Opens the Tools menu

Alt+H Opens the Help menu

File Menu
Defines keyboard equivalents used in the File Menu for Oracle Hyperion Planning accessibility.

Keyboard equivalents used in the File menu.

Table 3-238    Keyboard Equivalents for the File Menu

Keys Action

N, F Selects New, and then selects Data Form

N, R Selects New, and then selects Report

N, T Selects New, and then selects Task List

N, E Selects New, and then selects Variable

N, L Selects New, and then selects Smart List

N, M Selects New, then selects Menu

O Selects Open

O, U Selects Open, and then selects URL
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Table 3-238    (Cont.) Keyboard Equivalents for the File Menu

Keys Action

O, P Selects Open, and then selects Application

V Selects Open in Smart View

C Selects Close

C, C Selects Close, and then selects Current

C, A Selects Close, and then selects All

C, O Selects Close, and then selects Others

F Selects Preferences

G Selects Logout

X Selects Exit

Edit Menu
Defines keyboard equivalents used in the Edit menu for Oracle Hyperion Planning accessibility.

Keyboard equivalents used in the Edit menu.

Table 3-239    Keyboard Equivalents for the Edit Menu

Keys Action

J Selects Adjust

G Selects Grid Spread

L Selects Mass Allocate

O Selects Comment

K Selects Lock and Unlock Cells

U Selects Supporting Detail

E Selects Add/Edit Document

T Selects Annotate Planning Unit

D Selects Drill Through

View Menu
These keyboard equivalents are used in the View Menu in basic mode for Oracle Hyperion
Planning accessibility.

Table 3-240    Keyboard Equivalents for the View Menu

Keys Action

T, T Selects Task List, and then selects Task List

T, R Selects Task List, and then selects Report

T, S Selects Task List, and then selects Status

A Selects Edit Account Annotations
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Table 3-240    (Cont.) Keyboard Equivalents for the View Menu

Keys Action

C Selects and toggles Show Dimension Label on
Page

I Selects Instructions

C Selects Currency

H Selects Refresh

Ctrl+Alt+0 (zero) Selects View Masthead

Ctrl+Alt+1 Selects View Pane

Tools Menu
Defines keyboard equivalents used in the Tools Menu for Oracle Hyperion Planning
accessibility.

Table 3-241    Keyboard Equivalents for the Tools Menu

Keys Action

L Selects Manage Approvals

V Selects Copy Version

R Selects Business Rules

S Selects Job Console

O Selects Custom Links

E Selects Export as Spreadsheet

A, C Selects Ad Hoc, and then selects New Ad Hoc Grid

A, A Selects Ad Hoc, and then selects Analyze

A, S Selects Ad Hoc, and then selects Save Ad Hoc
Grid

A, O Selects Ad Hoc, and then selects Ad Hoc Options

A, Z, N Selects Ad Hoc, then selects Zoom In, and then
selects Zoom in Next Level

A, Z, V Selects Ad Hoc, and then selects Zoom In, and
then selects Zoom in All Levels

A, Z, B Selects Ad Hoc, and then selects Zoom In, and
then selects Zoom in Bottom Level

A, M Selects Ad Hoc, and then selects Zoom Out

A, R Selects Ad Hoc, and then selects Remove Only

A, K Selects Ad Hoc, and then selects Keep Only
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Administration Menu
Defines keyboard equivalents used in the Administration Menu for Oracle Hyperion Planning
accessibility.

Table 3-242    Keyboard Equivalents for the Administration Menu

Keys Action

M, S Selects Manage, and then selects Tablet Access

M, F Selects Manage, and then selects Data Forms and
Ad Hoc Grids

M, M Selects Manage, and then selects Menus

M, T Selects Manage, and then selects Task Lists

M, L Selects Manage, and then selects Smart Lists

M, E Selects Manage, and then selects Variable

M, B Selects Manage, and then selects Business Rule
Security

M, C Selects Manage, and then selects Clear Cell
Details

M, Y Selects Manage, and then selects Copy Data

M, D Selects Manage, and then selects Dimensions

M, A Selects Manage, and then selects Alias Tables

M, V Selects Manage, and then selects Currency
Conversions

M, X Selects Manage, and then selects Exchange Rates

A, M Selects Application, then selects Broadcast
Messages

A, P Selects Application, and then selects Properties

A, R Selects Application, and then selects Reports

A, T Selects Application, and then selects Statistics

A, S Selects Application, and then selects Settings

A, E Selects Application, and then selects Create

A, D Selects Application, and then selects Delete

A, G Selects Application, and then selects Register

A, C Selects Application, and then selects Create
Database

A, B Selects Application, and then selects Refresh
Database

P, P Selects Approvals, and then selects Planning Unit
Hierarchy

P, A Selects Approvals, then selects Scenario and
Version Assignment

P, I Selects Approvals, and then selects File Based
Import and Export

R Selects Map Reporting Application

D, C Selects Data Source, and then selects Create
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Table 3-242    (Cont.) Keyboard Equivalents for the Administration Menu

Keys Action

D, E Selects Data Source, and then selects Edit

D, D Selects Data Source, and then selects Delete

L Selects Data Load Settings

O Outline Load

O,I Import from file

O,E Export metadata to file

O,D Export data to file

Help Menu
Defines keyboard equivalents used in the Help Menu for Oracle Hyperion Planning
accessibility.

Keyboard equivalents used in the Help menu.

Table 3-243    Keyboard Equivalents for the Help Menu

Keys Action

T Selects Help on this Topic

C Selects Contents

S Selects Technical Support

E Selects EPM Documentation

A Selects About Oracle Enterprise Performance
Management System

Tool Bar
Defines keyboard equivalents used in the Tool Bar for Oracle Hyperion Planning accessibility.

Table 3-244    Keyboard Equivalents for the Tool Bar

Keys Action

Ctrl+S Save

Ctrl+H Refresh the Grid

Ctrl+P Print

Ctrl+J Adjust Data function on Grid

Ctrl+K Lock and unlock cells on the Grid

Ctrl+M Mass Allocate

Ctrl+C Copy

Ctrl+V Paste

Ctrl+X Cut

Ctrl+E Document Attachment

Ctrl+U Supporting Details

Ctrl+I Instructions
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Table 3-244    (Cont.) Keyboard Equivalents for the Tool Bar

Keys Action

Ctrl+Alt+E Pie Chart View in Task List Status

Ctrl+Alt+G Gantt Chart View in Task List Status

Alt+R Previous Incomplete (In Task List Wizard)

Alt+I Next Incomplete (In Task List Wizard)

Alt+P Previous task (In Task List Wizard)

Alt+N Next Task (In Task List Wizard)

Alt+H Task List Status Home Page

Ctrl+Alt+C Focus on the Completed checkbox (if enabled) in Task list Wizard

Task Manager Shortcuts
Defines keyboard equivalents used in Task Manager accessibility.

Taskflow Listing Summary

Buttons Shortcut

New Alt+W
Edit Alt+I
Delete Alt+Q
Save As Alt+S
Run Now Alt+U
Access Control Alt+C
Schedule
Taskflow

Alt+K

New/Save as/ Define Taskflow

Buttons Shortcut

Submit Alt+Q
Cancel Alt+L

Run Now

Buttons Shortcut

OK Alt+O

Access Control / Schedule Taskflow

Buttons Shortcut

Save Alt+S
Cancel Alt+L
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TaskFlow Status Summary

Buttons Shortcut

Search Alt+R
Refresh Alt+H
Stop Alt+P
Delete Alt+Q
Delete All Alt+L
Cancel Alt+L

Predictive Planning in Smart View

Enabling Accessibility for Predictive Planning in Smart View
Accessibility is the extent to which products, systems, and so on can be used by people with a
wide range of disabilities. Specifically, accessibility is the ability of products to support the
needs of users with visual impairments—including blindness, partial sight (low vision), and
color blindness—and motor impairments that prevent them from using a mouse or a standard
keyboard.

Predictive Planning supports accessibility at all times through keyboard shortcuts and other
means. Users who require additional support can activate Accessibility mode with the following
features:

• Series or other distinctions in charts have different patterns, not just different colors.

• Accessible text is provided in blank charts to indicate whether data is available or why it is
not.

• Microsoft Excel charts are included in reports by default and values of the chart series are
written out to the report spreadsheet.

To activate Accessibility mode in Predictive Planning in Oracle Smart View for Office:

1. Select Options in the Predictive Planning ribbon.

2. Select Enable accessibility options.

3. Click OK.

Note:

To deactivate Accessibility mode in Predictive Planning in Smart View, clear the
Enable accessibility options selection in the Options dialog.

Predictive Planning in Smart View Accessibility Features
Related Topics

• Using the Tab and Arrow Keys in the Predictive Planning User Interface

• Tab Order in Dialogs
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Using the Tab and Arrow Keys in the Predictive Planning User Interface
The main Predictive Planning options are accessed with keyboard equivalents. After a menu is
open, the Tab key or Down Arrow key highlights commands in a circular sequence (tabbing
from the last item moves focus to the first item). Using Shift+Tab or the Up Arrow highlights
commands in the opposite direction.

Tab Order in Dialogs
Default tab order in the Predictive Planning dialogs flows from left to right, top to bottom. Tab
can be used to access the first cell of a table or subwindow of a dialog, but then arrow keys are
needed to move to additional cells or items in the subwindow.

Keyboard Equivalents for the Predict Ribbon
In Oracle Smart View for Office and Oracle Hyperion Planning, use Alt+y, p to display the
Predict ribbon. Then, use Alt+b to select the ribbon. With the Predict ribbon selected, use the
keys in Table 1 to select ribbon icons.

Note:

For other keyboard equivalents used by Predictive Planning , see Predictive Planning
in Smart View Keyboard Equivalents for Dialog Boxes.

Note:

Oracle tries to avoid keyboard equivalent conflicts; if a key combination is the same
as one on a Microsoft Excel menu, you can use the Down Arrow key to access the
command you want. Commands are listed in the same order in which they are
displayed onscreen.

Table 3-245    Keyboard Equivalents for Predictive Planning Ribbon Buttons

Press Alt-b, Then These Keys Action

s Set Up Form; opens the Set Up Form dialog for administrators
and users whose roles allow them to modify Planning forms

p, p Predict; runs a Predictive Planning prediction

p, m Quick Predict for selected members

p, q Quick Predict to selected cells

c Comparison Views; displays predefined comparison views;
use the Up and Down Arrow keys to move through the list of
views

e Edit Current View; modifies the currently displayed
comparison chart view

n New View; creates a new comparison chart view
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Table 3-245    (Cont.) Keyboard Equivalents for Predictive Planning Ribbon Buttons

Press Alt-b, Then These Keys Action

m Manage Views; enables you to edit, rename, remove, or
reorder any built-in or custom view

f Filter Results; displays results that meet certain criteria

t Paste Results; enables you to copy prediction results into a
scenario on the form

r Create Report; provides information about selected members

d Extract Data; builds tables of prediction results

h Help; displays the online Predictive Planning User's Guide

h, l Launch Crystal Ball; runs Oracle Crystal Ball if available

o Options; enables you to select and clear general Predictive
Planning option settings for the current session

Predictive Planning in Smart View Keyboard Equivalents for Dialog Boxes
The tables in this topic list keyboard equivalents that apply to Predictive Planning dialog boxes.
For ribbon keyboard equivalents, see Keyboard Equivalents for the Predict Ribbon. See 
Keyboard Equivalents for Dialog Controls Without Labels or Alt Activations, General Users for
keyboard equivalents for dialog controls without labels. If your security role enables you to set
up a form for use with Predictive Planning, see Keyboard Equivalents for Set Up Form Dialog.

Related Topics

• Keyboard Equivalents for Labeled Dialog Controls, General Users

• Keyboard Equivalents for Dialog Controls Without Labels or Alt Activations, General Users

• Keyboard Equivalents for Set Up Form Dialog

Keyboard Equivalents for Labeled Dialog Controls, General Users
The tables in this section are for all users of Predictive Planning and include keys for the
following:

• Table 1

• Table 2

• Table 3

• Table 4

• Table 5

• Table 6

• Table 7

• Table 8

• Table 9

• Table 10

• Table 11
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• Table 12

• Table 13

• Table 14

• Table 15

• Table 16

• Table 17

• Table 18

• Table 19

• Table 20

• Table 21

• Table 22

Table 3-246    Keyboard Equivalents: All Dialog Boxes for General Users

Keys Button

Alt+h, or F1 Help

Alt+r Reset

Alt+o OK

Alt+c, or Esc Cancel

Table 3-247    Keyboard Equivalents: Run Confirmation Dialog Controls

Keys Button

Alt+a Change member selection (Table 3)

Alt+n Change historical data (Table 4)

Alt+g Change prediction range (Table 4)

Alt+r Run prediction

Table 3-248    Keyboard Equivalents: Change Member Selection Dialog Controls

Keys Control

Alt+p Prediction type

Alt+k Skip 'read only' members

Alt+a Clear All

Alt+s Select All

Alt+r Reset

Table 3-249    Keyboard Equivalents: Change Historical Data and Change Prediction
Range Dialog Controls

Keys Control

Alt+s Start year

Alt+t Start period
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Table 3-249    (Cont.) Keyboard Equivalents: Change Historical Data and Change
Prediction Range Dialog Controls

Keys Control

Alt+e End year

Alt+n End period

Table 3-250    Keyboard Equivalents: Edit View and New View Dialog Controls

Keys Control

Alt+v View Name

Alt+a Auto

Alt+s Add Scenario

Alt+p Add Prediction

Alt+t Add Trend Line

Alt+e Remove

Table 3-251    Keyboard Equivalents: Add Prediction Data Dialog Controls

Keys Control

Alt+p Prediction (current)

Alt+r Prediction worst case

Alt+e Prediction best case

Alt+d Prediction fit line

Table 3-252    Keyboard Equivalents: Add Trend Line Dialog Controls

Keys Control

Alt+l Linear trend line

Alt+r Growth rate

Alt+p _ % per _

Alt+u Use compounding

Table 3-253    Keyboard Equivalents: Manage Views Dialog Controls

Keys Button

Alt+e Edit

Alt+r Rename

Alt+v Remove
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Table 3-254    Keyboard Equivalents: Rename View Dialog Controls

Keys Action

Alt+e Enter a name for the view

Table 3-255    Keyboard Equivalents: Filter Results Dialog Controls

Keys Control

Alt+a Add row

Table 3-256    Keyboard Equivalents: Paste Results Button, Lower Half

Keys Action: Paste Results for

Alt+t Current member

Alt+a All members

Alt+f Filtered members

Alt+s Selected members

Table 3-257    Keyboard Equivalents: Paste Results Dialog Controls

Keys Control

Alt+r From

Alt+t To: Scenario

Alt+e Entire range

Alt+f First _ periods on form

Table 3-258    Keyboard Equivalents: Create Report Dialog Controls

Keys Control

Alt+a All members

Alt+f Filtered members

Alt+m Selected members

Alt+p Preferences

Table 3-259    Keyboard Equivalents: Report Tab of the Report Preferences Dialog,
Report Summary Details

Keys Control

Alt+e Report sections list; first selection is Report
Summary with the following Details selections:

Alt+r Report title

Alt+u Run date, time

Alt+d Data attributes

Alt+n Run preferences

Alt+p Prediction results
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Table 3-260    Keyboard Equivalents: Report Tab of the Report Preferences Dialog,
Predictor Members Details

Keys Control

Alt+e Report sections list; second selection is Predictor
Members with the following Details selections:

Alt+r Chart

Alt+p Predicted values

Alt+t Statistics

Alt+m Methods

Table 3-261    Keyboard Equivalents: Options Tab of the Report Preferences Dialog

Keys Control

Alt+n New workbook

Alt+u Current workbook

Alt+t Sheet name

Alt+l Include cell locations

Alt+g Image

Alt+e Microsoft Excel chart

Table 3-262    Keyboard Equivalents: Extract Data Dialog Controls

Keys Control

Alt+a All members

Alt+f Filtered members

Alt+m Selected members

Alt+p Preferences

Table 3-263    Keyboard Equivalents: Data Tab of the Extract Data Preferences Dialog,
Results Table Details

Keys Control

Alt+s Data to extract list; first selection is Results Table
with the following Details selections:

Alt+d Past data

Alt+f Future data

Table 3-264    Keyboard Equivalents: Data Tab of the Extract Data Preferences Dialog,
Methods Table Details

Keys Control

Alt+s Data to extract list; second selection is Methods
Table with the following Details selections:

Alt+u Accuracy

Alt+e Errors

Alt+a Parameters
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Table 3-264    (Cont.) Keyboard Equivalents: Data Tab of the Extract Data Preferences
Dialog, Methods Table Details

Keys Control

Alt+n Ranking

Table 3-265    Keyboard Equivalents: Options Tab of the Extract Data Preferences Dialog

Keys Control

Alt+n New workbook

Alt+u Current workbook

Alt+t Sheet name

Alt+a AutoFormat

Table 3-266    Keyboard Equivalents: Help Button, Right Half

Keys Action: Displays

Alt+c Contents

Alt+s Technical Support

Alt+a About

Alt+l Launch Crystal Ball; runs Oracle Crystal Ball if
available

Table 3-267    Keyboard Equivalents: Options Dialog

Keys Control

Alt+r Show ribbon only for valid Planning forms

Alt+l Collapse rows and columns on form during filter
operations

Alt+t Reset; for "Do not showcheckboxes"

Alt+f Format (for period and year)

Alt+p Separator (date)

Alt+e Enable accessibility options

Keyboard Equivalents for Dialog Controls Without Labels or Alt Activations, General
Users

Table 1 lists keyboard equivalents for controls that either have no labels or do not have a
keyboard equivalent that is highlighted when you press Alt.

Table 3-268    Keyboard Equivalents for Controls without Labels or Alt Key Activation

Keys Action

Ctrl+Up Arrow In the Predictive Planning panel, selects the
previous member

In the New View, Modify View, and Manage Views
dialog box, moves a view up in order
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Table 3-268    (Cont.) Keyboard Equivalents for Controls without Labels or Alt Key
Activation

Keys Action

Ctrl+Down Arrow In the Predictive Planning panel, selects the next
member

In the New View, Modify View, and Manage Views
dialog box, moves a view down in order

Ctrl+p In the Predictive Planning panel, displays the Chart
Preferences dialog

Ctrl+z In the Predictive Planning panel, selects the Chart
Scale slide control to display more or less detail in
the chart

Ctrl+t In the Predictive Planning panel, detaches the
pane from the side of the window; same as the Pin
Panel button

F1 In the Predictive Planning panel, displays online
Help

Keyboard Equivalents for Set Up Form Dialog
The following tables in this section are for administrators and users whose roles allow them to
modify Oracle Hyperion Planning forms. The tables include keys for the Set Up Form dialog
tabs:

• Table 1

• Table 2

• Table 3

• Table 4

• Table 5

Table 3-269    Keyboard Equivalents: Set Up Form Dialog, All Tabs

Keys Button

Alt+h Help

Alt+r Reset

Alt+d Set Default

Alt+o OK

Alt+c Cancel

Table 3-270    Keyboard Equivalents: Set Up Form Dialog, Data Source Tab

Keys Control

Alt+p Current Planning application

Alt+u Use all historical data

Alt+s Selected data range

Alt+t Start year

Alt+a Start period
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Table 3-270    (Cont.) Keyboard Equivalents: Set Up Form Dialog, Data Source Tab

Keys Control

Alt+e End year

Alt+n End period

Table 3-271    Keyboard Equivalents: Set Up Form Dialog, Map Names Tab

Keys Control

Alt+s Scenario

Alt+1 Scenario 1

Alt+2 Scenario 2

Alt+b Base case scenario

Alt+w Worst case scenario

Alt+e Best case scenario

Alt+a Automatically paste results to prediction scenarios

Table 3-272    Keyboard Equivalents: Set Up Form Dialog, Member Selection Tab

Keys Control

Alt+b Bottom-up

Alt+t Top-down

Alt+f Full

Alt+k Skip 'read only' members

Table 3-273    Keyboard Equivalents: Set Up Form Dialog, Options Tab

Keys Control

Alt+u Automatic

Alt+m Manual

Alt+f Fill in missing values

Alt+d Adjust outliers

Alt+n Nonseasonal methods

Alt+s Seasonal methods

Alt+i ARIMA

Alt+r RMSE

Alt+a MAD

Alt+p MAPE

Alt+b Select periods based on form

Alt+l Manual

Alt+t Prediction interval

Profitability and Cost Management
Related Topics

• Profitability and Cost Management Accessibility Features
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• Profitability and Cost Management Keyboard Equivalents

Profitability and Cost Management Accessibility Features
Related Topics

• Switching Between Tabs in the User Interface

• Using the Tab Key for Import Configuration Wizard

• Using Context Menus

• Making Multiple Selections

Switching Between Tabs in the User Interface
To switch from one tab to another tab, such as the Driver Rules and Exception tabs on the
Driver Selections screen, use the arrow keyboards keys.

Using the Tab Key for Import Configuration Wizard
When accessing the Import Configuration Wizard, the Help button is highlighted as the first
default field, and the title bar of the wizard is not read by JAWS.

To access the first readable field, press the Tab key, and continue to move through the screen
as usual.

To open tabs on the screen, for example, when you have selected Validate, then Model
Validation, use the Tab key to navigate to the first tab (Unused Drivers). With the focus on the
first tab, use the keyboard arrow keys to move to each tab. When a tab is selected, it expands
to show the tab contents. Use the Tab key to navigate the fields on each screen tab.

Using Context Menus
Context menus enable you to select display options and filters for data, such as Grid or Tree
View, Alias or Name, Filter and Sort.

To select a state from the Context menu:

1. Tab to the Context Menu icon.

2. Focus on the Context Menu icon, and then press Enter to display the options.

3. Use the up and down arrow keys to select the item from the menu, and then press Enter.

Making Multiple Selections
You can use the CTRL key and arrow keys to make multiple selections of items that are not
adjacent to each other.

To select multiple random items:

1. Press down the CTRL key and hold it down until all selections have been made.

2. Use the up and down arrows keys to navigate to the item to be selected, and then press
the Space Bar to select or deselect the item.

3. Repeat these steps for each item to be selected or deselected.

4. Release the CTRL key to finalize the selections.
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Profitability and Cost Management Keyboard Equivalents
Related Topics

• About Profitability and Cost Management Keyboard Equivalents

• Navigation Shortcuts for Standard Profitability Applications

• Navigation Shortcuts for Detailed Profitability Applications

About Profitability and Cost Management Keyboard Equivalents
Oracle Hyperion Profitability and Cost Management provides navigation shortcuts to the main
tasks in the application and to available action points (buttons, toolbars, icons, and so on).

To access a list of shortcut navigation keys for the current screen, select Alt+0 at any time.
These navigation shortcuts provide access to all enabled actions for the page.

An Information pane lists available navigation shortcuts for the dialog box. If an option is
available for action, the shortcut is "enabled." If an option is unavailable for the current
situation, the shortcut is "disabled".

Profitability and Cost Management offers two different types of applications that have slight
differences between the menu options. To simplify the access to the different navigation
shortcuts for your application type, refer to the appropriate sections:

• Navigation Shortcuts for Standard Profitability Applications

• Navigation Shortcuts for Detailed Profitability Applications

Navigation Shortcuts for Standard Profitability Applications
Related Topics

• Standard Profitability and Cost Management Main Menu Options

• Standard Profitability Manage Models Task Area

• Standard Profitability Manage Allocations Task Area

• Standard Profitability Validate Task Area

• Standard Profitability Calculate Task Area

• Standard Profitability Job Process Task Area

Standard Profitability and Cost Management Main Menu Options

Table 3-274    Standard Profitability and Cost Management Main Menu Options

Keys Action

M Model: Open Models menu
Ctrl+Alt+S Model, Model Summary: Opens Model Summary screen:

• System Information
• Model Level Preference
Use arrow key to move focus to each tab.

Ctrl+Alt+G Model, Stages: Open the Stages screen
Ctrl+Alt+P Model, POV Manager: Open the POV Manager screen
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Table 3-274    (Cont.) Standard Profitability and Cost Management Main Menu Options

Keys Action

Ctrl+Alt+I Model, Import Staging Tables: Open the Import Staging Tables
screen

A Allocations: Expand Allocations
Use arrow key to navigate to
submenus for Driver
Definitions and Driver
Selection

Allocations, Drivers: Open the submenus for Driver Definitions
and Driver Selection

Ctrl+Alt+H Allocations, Drivers, Driver Definitions: Open the driver
Definitions screen

Ctrl+Alt+J Allocations, Drivers, Driver Selections: Open the Driver
Selections

Ctrl+Alt+K Allocations, Assignment Rule Definitions: Open Assignment Rule
Definitions

Ctrl+Alt+A Allocations, Assignments: Open Assignments screen
Ctrl+Alt+E Allocations, Data Entry: Open Data Entry screen
Ctrl+Alt+T Allocations, Trace Allocations: Open Trace Allocations
Ctrl+Shift+E Allocations, Export Traceability: Open Export Traceability
V Validate: Expand Validation
Ctrl+Alt+M Validate, Model Validation: Open the Model Validation screen
Ctrl+Alt+B Validate, Stage Balancing: Open Stage Balancing
Ctrl+Alt+R Validate, Driver Data Report: Open Driver Data report
C Calculate: Expand Calculation
Ctrl+Alt+D Calculate, Manage Database: Open Manage Database screen
Ctrl+Alt+C Calculate, Manage Calculation: Open Manage Calculation
J Job Process: Expand Job Process
Ctrl+Alt+F Job Process, Manage Task Flow: Open Manage Task Flow screen
Ctrl+Alt+U Job Process, Search Process: Open Search Process
Ctrl+Alt+V Job Process, Search Task: Open Search Task
H Help: Expand Help options menu
T or F1 Help, Help on this Topic: Open the online help for the currently

displayed page
C Help, Contents: Open the online guide. You can use the Table of

Contents, Index or enter a term in Search.
S Technical Support: Open the Technical Support Link
E EPM Documentation: Open the link to the Enterprise

Performance Management System Documentation Library. From
here, you select the release, and can access all published
documents for the release.

A About Oracle Enterprise Performance Management System
Workspace, Fusion Edition: Open the About screen, that displays
the Workspace version, and the versions for all associated
components.
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Standard Profitability Manage Models Task Area

Table 3-275    Standard Profitability Manage Models Task Area

Keys Action

Alt+0 anytime to display
options

Information Pane

Ctrl+Alt+S Model Summary: Opens Model Summary screen:
• System Information
• Model Level Preference
Use arrow key to move focus to each tab.

Alt+3 Model Summary, Save System Information Tab: Saves information on
the System Information tab

Alt+3 Model Summary, Save Model Level Preference Tab: Saves information
on the Model Level Preference tab

Ctrl+Alt+G Stages: Opens the Stages tab
Alt+1 Stages, Add new stage: Opens the Stage dialog box to add details for a

new stage (such as name, description, prefix, and so on.)
Alt+2 Stages, Edit stage: Opens the Stage dialog box to edit details for an

existing stage (such as name, description, prefix, and so on.)
Alt+4 Stages, Delete stage: Opens the confirmation dialog box to confirm

deletion of the stage.
Alt+7 Stages, Move stage up
Alt+8 Stages, Move stage down
Alt+1 Stage Dialog Box, Add new dimension: Opens new stage dialog box to

select stage dimensions
Alt+4 Stage Dialog Box, Delete dimension: Opens stage dialog box to select

stage dimension for deletion
Alt+7 Stages Dialog Box, Move dimension up
Alt+8 Stages Dialog Box, Move dimension down
Alt+H Stage Dialog Box, Help
Alt+L Stages Dialog Box, Cancel
Alt+O Stages Dialog Box, OK
Ctrl+Alt+P POV Manager
Alt+1 POV Manager, Status Tab, Add new POV
Alt+2 POV Manager, Status Tab, Edit POV
Alt+4 POV Manager, Status Tab, Delete POV
Alt+5 POV Manager, Copy Tab, Run Now
Alt+6 POV Manager, Copy Tab, Run Later
Alt+5 POV Manager, Delete Tab, Delete
Ctrl+Alt+I Import Staging Tables
Alt+1 Import Staging Tables, Add new import configuration
Alt+2 Import Staging Tables, Edit import configuration
Alt+4 Import Staging Tables, Delete import configuration
Alt+5 Import Staging Tables, Run import configuration
Alt+N Import Data Wizard, Step 1 of 3, Next
Alt+B Import Data Wizard, Step 1 of 3, Back
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Standard Profitability Manage Allocations Task Area

Table 3-276    Standard Profitability Manage Allocations Task Area

Keys Function

Alt+0 anytime to
display options

Information Pane

Ctrl+Alt+H Driver Definitions
Alt+1 Driver Definitions, Add driver: Opens the Drivers dialog box to add details

for a new driver (such as name, description, basis or formula type, and so
on.)

Alt+2 Driver Definitions, Edit driver: Opens the Drivers dialog box to edit details
for an existing driver (such as name, description, basis or formula type,
and so on.)

Alt+4 Driver Definitions, Delete driver: Opens the confirmation dialog box to
confirm deletion of the driver.

Alt+8 Driver Definitions, Create duplicate driver: Select a driver, and then opens
the Create Duplicate Driver dialog box. Enter the new driver name.

Ctrl+Alt+J Driver Selections, Driver Rules Tab
Alt+1 Driver Selections, Driver Rules Tab, Add driver rule
Alt+4 Driver Selections, Driver Rules Tab, Delete driver rule
Ctrl+Alt+O Driver Selections, Exceptions Tab,
Alt+1 Driver Selections, Exceptions Tab, Add driver exception
Alt+4 Driver Selections, Exceptions Tab, Delete driver exception
Ctrl+Alt+K Assignment Rule Definitions
Alt+1 Assignment Rule Definitions, Add new assignment rule definition
Alt+2 Assignment Rule Definitions, Edit existing assignment rule definition
Alt+4 Assignment Rule Definitions, Delete existing assignment rule definition
Ctrl+Alt+A Assignments
Alt+1 Assignments, Add new assignments
Alt+4 Assignments, Delete assignments
Alt+7 Assignments, Open assignment rules management dialog box
Alt+1 Assignment Rules Management dialog box, Add assignment rule
Alt+2 Assignment Rules Management dialog box, Edit assignment rule
Alt+4 Assignment Rules Management dialog box, Delete assignment rule
Ctrl+Alt+E Data Entry, Stage Data
Alt+3 Data Entry, Stage Data, Save Data
Alt+7 Data Entry, Stage Data, Manage Views dialog box
Alt+1 Data Entry, Stage Data, Manage Views dialog box, Add view
Alt+2 Data Entry, Stage Data, Manage Views dialog box, Rename view
Alt+4 Data Entry, Stage Data, Manage Views dialog box, Delete view
Ctrl+Alt+E Data Entry, Driver Data

Use arrow keys to move focus to Driver Data tab.

Ctrl+Alt+T Trace Allocations
Alt+5 Trace Allocations, Trace

Chapter 3
Profitability and Cost Management

3-108



Standard Profitability Validate Task Area

Table 3-277    Standard Profitability Validate Task Area

Keys Action

Alt+0 anytime to
display options

Information Pane

Ctrl+Alt+M Model Validation, Model Data Registration
Use arrow keys to move to other tabs.

Alt+5 Model Validation, any tab, Validate
Ctrl+Alt+B Stage Balancing Report
Alt+5 Stage Balancing Report, Run
Ctrl+Alt+R Driver Data Report
Alt+5 Driver Data Report, Generate

Standard Profitability Calculate Task Area

Table 3-278    Standard Profitability Calculate Task Area

Keys Action

Alt+0 anytime to
display options

Information Pane

Ctrl+Alt+D Manage Database, Calculation Database
Alt+5 Manage Database, Calculation Database, Deploy Now
Alt+6 Manage Database, Calculation Database, Deploy Later
Ctrl+Alt+D Manage Database, Reporting Database:

Use arrow key to move focus to Reporting Database tab.

Alt+5 Manage Database, Reporting Database, Deploy Now
Alt+6 Manage Database, Reporting Database, Deploy Later
Ctrl+Alt+C Manage Calculation
Alt+1 Manage Calculation, Genealogy Tab, Add Genealogy Selection
Alt+2 Manage Calculation, Genealogy Tab, Edit Genealogy Selection
Alt+4 Manage Calculation, Genealogy Tab, Delete Genealogy Selection
Alt+5 Manage Calculation, Allocation Tab, Run Now
Alt+6 Manage Calculation, Allocation Tab, Run Later
Alt+5 Manage Calculation, Genealogy Tab, Run Now
Alt+6 Manage Calculation, Genealogy Tab, Run Later
Alt+5 Manage Calculation, Transfer Data Tab, Transfer Now
Alt+6 Manage Calculation, Transfer Data Tab, Transfer Later

Standard Profitability Job Process Task Area

Table 3-279    Standard Profitability Job Process Task Area

Keyboard
Shortcut

Function

Alt+0 anytime to
display options

Information Pane
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Table 3-279    (Cont.) Standard Profitability Job Process Task Area

Keyboard
Shortcut

Function

Ctrl+Alt+F Manage Taskflow:
Ctrl+Alt+U Task Status: Enter criteria for a taskflow and view its status.
Ctrl+Alt+V Task Details: Select criteria from My Tasks to view details.

Navigation Shortcuts for Detailed Profitability Applications
Related Topics

• Detailed Profitability and Cost Management Main Menu Options

• Detailed Profitability Manage Models Task Area

• Detailed Profitability Manage Allocations Task Area

• Detailed Profitability Validate Task Area

• Detailed Profitability Calculate Task Area

• Detailed Profitability Job Process Task Area

Detailed Profitability and Cost Management Main Menu Options

Table 3-280    Detailed Profitability and Cost Management Main Menu Options

Keys Action

M Model: Open Models menu
Ctrl+Alt+S Model, Model Summary: Opens Model Summary screen:

• System Information
• Model Level Preference
Use arrow key to move focus to each tab.

Ctrl+Alt+T Model, Model Data Registration:
• Registration
• Column Mapping
• Table Joins
• Summary
Use arrow key to move focus to each tab.

Ctrl+Alt+G Model, Stages: Open the Stages screen
Ctrl+Alt+P Model, POV Manager: Open the POV Manager screen
Ctrl+Alt+I Model, Import Staging Tables: Open the Import Staging Tables screen
A Allocations: Expand Allocations
Use arrow key
to navigate to
submenus for
Driver
Definitions and
Driver
Selection

Allocations, Drivers: Open the submenus for Driver Definitions and Driver
Selection

Ctrl+Alt+H Allocations, Drivers, Driver Definitions: Open the driver Definitions screen
Ctrl+Alt+J Allocations, Drivers, Driver Selections: Open the Driver Selections
Ctrl+Alt+K Allocations, Assignment Rule Definitions: Open Assignment Rule Definitions
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Table 3-280    (Cont.) Detailed Profitability and Cost Management Main Menu Options

Keys Action

Ctrl+Alt+A Allocations, Assignments: Open Assignments screen
Ctrl+Alt+O Allocations, Stage Object Calculations: For Detailed Profitability, open Stage

Object Calculations
V Validate: Expand Validation
Ctrl+Alt+M Validate, Model Validation: Open the Model Validation screen
Ctrl+Alt+B Validate, Stage Balancing: Open Stage Balancing
C Calculate: Expand Calculation
Ctrl+Alt+D Calculate, Manage Database: Open Manage Database screen
Ctrl+Alt+C Calculate, Manage Calculation: Open Manage Calculation
J Job Process: Expand Job Process
Ctrl+Alt+L Job Process, Job Library; Open Job Library
Ctrl+Alt+F Job Process, Manage Task Flow: Open Manage Task Flow screen
Ctrl+Alt+U Job Process, Search Process: Open Search Process
Ctrl+Alt+V Job Process, Search Task: Open Search Task
H Help: Expand Help options menu
T or F1 Help, Help on this Topic: Open the online help for the currently displayed page
C Help, Contents: Open the online guide. You can use the Table of Contents, Index

or enter a term in Search.
S Technical Support: Open the Technical Support Link
E EPM Documentation: Open the link to the Enterprise Performance

Management System Documentation Library. From here, you select the release,
and can access all published documents for the release.

A About Oracle Enterprise Performance Management System Workspace, Fusion
Edition: Open the About screen, that displays the Workspace version, and the
versions for all associated components.

Detailed Profitability Manage Models Task Area

Table 3-281    Detailed Profitability Manage Models Task Area

Keys Action

Alt+0 anytime to
display options

Information Pane

Ctrl+Alt+S Manage Model, Model Summary: Opens Model Summary screen:
• System Information
• Model Level Preference
Use arrow key to move focus to each tab.

Alt+3 Manage Model, Model Summary, Save System Information Tab: Saves
information on the System Information tab

Alt+3 Manage Model, Model Summary, Save Model Level Preference Tab: Saves
information on the Model Level Preference tab

Ctrl+Alt+T Manage Model, Model Data Registration:
• Registration
• Column Mapping
• Table Joins
• Summary
Use arrow key to move focus to each tab.
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Table 3-281    (Cont.) Detailed Profitability Manage Models Task Area

Keys Action

Alt+1 Manage Model, Model Data Registration, Registration tab, Add new table
Alt+2 Manage Model, Model Data Registration, Registration tab, Edit table
Alt+4 Manage Model, Model Data Registration, Registration tab, Delete table
Alt+8 Manage Model, Model Data Registration, Registration tab, Duplicate table
Alt+2 Manage Model, Model Data Registration, Column Mapping tab, Edit

mapping
Alt+4 Manage Model, Model Data Registration, Registration tab, Delete mapping
Alt+1 Manage Model, Model Data Registration, Table Joins tab, Add new table join
Alt+2 Manage Model, Model Data Registration, Table Joins tab, Edit table join
Alt+4 Manage Model, Model Data Registration, Table Joins tab, Delete table join
Alt+4 Manage Model, Stages, Table Joins tab, Delete table join
Ctrl+Alt+G Manage Model, Stages: Opens the Stages screen
Alt+1 Manage Model, Stages, Add new stage: Opens the Stage dialog box to add

details for a new stage (such as name, description, prefix, and so on.)
Alt+2 Manage Model, Stages, Edit stage: Opens the Stage dialog box to edit details

for an existing stage (such as name, description, prefix, and so on.)
Alt+4 Manage Model, Stages, Delete stage: Opens the confirmation dialog box to

confirm deletion of the stage.
Alt+7 Stages, Move stage up
Alt+8 Stages, Move stage down
Alt+1 Stage Dialog Box, Add new dimension: Opens new stage dialog box to select

stage dimensions
Alt+4 Stage Dialog Box, Delete dimension: Opens stage dialog box to select stage

dimension for deletion
Alt+7 Stages Dialog Box, Move dimension up
Alt+8 Stages Dialog Box, Move dimension down
Alt+H Stage Dialog Box, Help
Alt+L Stages Dialog Box, Cancel
Alt+O Stages Dialog Box, OK
Ctrl+Alt+P Manage Model, POV Manager
Alt+1 POV Manager, Status Tab, Add new POV
Alt+2 POV Manager, Status Tab, Edit POV
Alt+4 POV Manager, Status Tab, Delete POV
Alt+5 POV Manager, Copy Tab, Run Now
Alt+6 POV Manager, Copy Tab, Run Later
Alt+5 POV Manager, Delete Tab, Delete
Ctrl+Alt+I Manage Model, Import Staging Tables
Alt+1 Import Staging Tables, Add new import configuration
Alt+2 Import Staging Tables, Edit import configuration
Alt+4 Import Staging Tables, Delete import configuration
Alt+5 Import Staging Tables, Run import configuration
Alt+N Import Data Wizard, Step 1 of 3, Next
Alt+B Import Data Wizard, Step 1 of 3, Back
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Detailed Profitability Manage Allocations Task Area

Table 3-282    Detailed Profitability Manage Allocations Task Area

Keys Function

Alt+0 anytime to
display options

Information Pane

Ctrl+Alt+H Driver Definitions
Alt+1 Driver Definitions, Add driver: Opens the Drivers dialog box to add details

for a new driver (such as name, description, basis or formula type, and so
on.)

Alt+2 Driver Definitions, Edit driver: Opens the Drivers dialog box to edit details
for an existing driver (such as name, description, basis or formula type,
and so on.)

Alt+4 Driver Definitions, Delete driver: Opens the confirmation dialog box to
confirm deletion of the driver.

Alt+8 Driver Definitions, Create duplicate driver: Select a driver, and then opens
the Create Duplicate Driver dialog box. Enter the new driver name.

Ctrl+Alt+J Driver Selections: Opens Driver Selections screen:
• Driver Rules
• Exceptions
Use arrow key to move focus to each tab.

Alt+1 Driver Selections, Driver Rules Tab, Add driver rule
Alt+4 Driver Selections, Driver Rules Tab, Delete driver rule
Alt+1 Driver Selections, Exceptions Tab, Add driver exception
Alt+4 Driver Selections, Exceptions Tab, Delete driver exception
Ctrl+Alt+K Assignment Rule Definitions
Alt+1 Assignment Rule Definitions, Add new assignment rule definition
Alt+2 Assignment Rule Definitions, Edit existing assignment rule definition
Alt+4 Assignment Rule Definitions, Delete existing assignment rule definition
Alt+8 Assignment Rule Definitions, Create duplicate assignment rule definition
Ctrl+Alt+A Assignments
Alt+2 Assignments, Reorder dimensions
Alt+4 Assignments, Unassign assignment rule
Alt+7 Assignments, Open bulk editor
Alt+9 Display information about assignment rule
Alt+1 Assignment Rules Management dialog box, Add assignment rule
Alt+2 Assignment Rules Management dialog box, Edit assignment rule
Alt+4 Assignment Rules Management dialog box, Delete assignment rule
Alt+8 Assignment Rules Management dialog box, Create duplicate assignment

rule
Ctrl+Alt+O Stage Object Calculation
Alt+1 Stage Object Calculation, Add Stage Object Calculation dialog box
Alt+2 Stage Object Calculation, Edit Stage Object Calculation dialog box
Alt+4 Stage Object Calculation, Delete Stage Object Calculation
Alt+7 Display information about stage object calculation
Alt+9 Display information about assignment rule
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Detailed Profitability Validate Task Area

Table 3-283    Detailed Profitability Validate Task Area

Keys Action

Alt+0 anytime to
display options

Information Pane

Ctrl+Alt+M Model Validation
Use arrow keys to navigate to each tab

Alt+5 Model Validation, any tab, Validate
Ctrl+Alt+B Stage Balancing Report
Alt+5 Stage Balancing Report, Run

Detailed Profitability Calculate Task Area

Table 3-284    Detailed Profitability Calculate Task Area

Keys Action

Alt+0 anytime to
display options

Information Pane

Ctrl+Alt+D Manage Database
Alt+1 Manage Database, Deploy
Ctrl+Alt+C Calculate:

• Manage Calculation
• Driver Operation Types
• Other Process Types
Use arrow key to move focus to each tab.

Caution:

CAUTION: Oracle recommends that only
experienced Database Administrators use the
Driver Operations Types or Other Process
Types options. Modifications to the Driver
Operation Types or Other Process Types may
have a profound impact on your applications,
and may corrupt your model or data.

Alt+1 Calculate, Manage Calculation, Move Data POV Up
Alt+2 Calculate, Manage Calculation, Move Data POV Down
Alt+5 Calculate, Manage Calculation, Run Now
Alt+6 Calculate, Manage Calculation, Run Later
Driver Operation
Types and Other
Process Types

CAUTION: Oracle recommends that only experienced Database
Administrators use the Driver Operations Types or Other Process Types
options. Modifications to the Driver Operation Types or Other Process
Types may have a profound impact on your applications, and may corrupt
your model or data.

Alt+1 Calculate, Driver Operation Types, Add driver operation type
Alt+2 Calculate, Driver Operation Types, Edit driver operation type
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Table 3-284    (Cont.) Detailed Profitability Calculate Task Area

Keys Action

Alt+4 Calculate, Driver Operation Types, Delete driver operation type
Alt+7 Calculate, Driver Operation Types, Restore Deleted Defaults
Alt+8 Calculate, Driver Operation Types, Restore All Defaults
Alt+4 Calculate, Other Process Types, Edit Other Process Type
Alt+8 Calculate, Other Process Types, Restore All Defaults

Detailed Profitability Job Process Task Area

Table 3-285    Detailed Profitability Job Process Task Area

Keyboard Shortcut Function

Alt+0 anytime to
display options

Information Pane

Ctrl+Alt+L Jobs Status: Job Library
Alt+4 Jobs Status, Job Library, Delete job
Alt+5 Jobs Status, Job Library, Stop job
Ctrl+Alt+F Jobs Status: Manage Task Flow - Enter criteria to view taskflow summary
Ctrl+Alt+U Jobs Status: Search Process: Enter criteria to view status for a selected

taskflow
Ctrl+Alt+V Jobs Status: Search Task - Select criteria from My Tasks to view details.
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